KODAK OFFICE HERO 6.1
All-in-One Printer

Extended User Guide
# Table of contents

1 Printer Overview
   Components................................................................................................................................................. 1
   Control panel ........................................................................................................................................... 2
   Home Center Software ................................................................................................................................. 4
   Ordering supplies ....................................................................................................................................... 5
   Configuring printer settings ....................................................................................................................... 6

2 Networking Your Printer
   Connecting to a wireless network ............................................................................................................. 7
   Before you connect .................................................................................................................................. 7
   Connecting to a wireless network using the Wi-Fi Setup Wizard ................................................................ 7
   Setting up an IP Address ............................................................................................................................. 11
   Viewing the network configuration ........................................................................................................... 12
   Printing the network configuration .......................................................................................................... 12
   Installing your printer on additional computers on the network .............................................................. 13
   Connecting to another KODAK All-in-One Printer .................................................................................... 13
   Connecting to an Ethernet network .......................................................................................................... 14
   Adding a wireless network connection to a USB-connected computer ..................................................... 15
   Changing from USB to a wireless connection ............................................................................................. 15
   Changing from USB to an Ethernet connection .......................................................................................... 16

3 Online Printer Management Tool
   Accessing the Online Printer Management Tool ..................................................................................... 18
   Using the Online Printer Management Tool ............................................................................................. 19
   Configuring printer settings ....................................................................................................................... 19
   Changing the printer name ......................................................................................................................... 20
   Adjusting fax settings ................................................................................................................................. 21
   Setting up Scan To Email ............................................................................................................................ 23
   Setting up Scan To Network Folder ........................................................................................................... 29
   Setting up Cloud Printing ........................................................................................................................ 33
   Changing printer settings for copying and printing .................................................................................. 35

4 Handling Paper
   Paper types .................................................................................................................................................. 38
   Paper sizes ............................................................................................................................................... 39
   Envelope sizes .......................................................................................................................................... 39
   Loading paper ......................................................................................................................................... 40
      Loading plain paper ................................................................................................................................. 40
      Loading photo paper ............................................................................................................................. 42
      Loading envelopes ................................................................................................................................. 43
   Loading originals .................................................................................................................................... 45
      Using the scanner glass ......................................................................................................................... 45
      Using the Automatic Document Feeder (ADF) ...................................................................................... 46
5 Printing

Copying documents.................................................................................................................................................. 47
Printing one-sided documents............................................................................................................................. 47
Printing two-sided documents ............................................................................................................................. 47
Printing forms from the control panel .................................................................................................................. 49
Printing pictures.................................................................................................................................................. 50
Viewing pictures on a memory card or USB-connected device ........................................................................ 50
Printing from a memory card or USB-connected device .................................................................................... 51
Printing from a wireless device ........................................................................................................................... 56
Transferring pictures to a computer .................................................................................................................... 57
  Transferring pictures to a computer with WINDOWS OS .................................................................................. 57
  Transferring pictures to a computer with MAC OS ........................................................................................... 57

6 Mobile Printing

Printing using Google Cloud Print ....................................................................................................................... 58
Printing using KODAK Email Print Service ......................................................................................................... 59
  Printing emails, documents, and pictures ......................................................................................................... 59
Printing pictures from a mobile device .................................................................................................................. 60
  Printing pictures from an iPhone, iPad, or iPod touch device .......................................................................... 60
  Printing pictures from a BLACKBERRY Device ................................................................................................. 60
  Printing pictures from an ANDROID OS Device ............................................................................................... 61

7 Copying

Loading originals for copying............................................................................................................................... 62
Copying a document ............................................................................................................................................. 62
  Using the default settings to copy a document ................................................................................................. 62
  Adjusting the settings and copying a document ............................................................................................... 63
  Changing the number of copies of a document ................................................................................................. 64
  Enlarging or reducing the size of a copy ........................................................................................................... 64
  Darkening or lightening a copy ......................................................................................................................... 65
Two-sided copying ............................................................................................................................................... 65
  Automatic two-sided copying ............................................................................................................................ 65
  Manual two-sided copying ................................................................................................................................. 66
Copying a photo ................................................................................................................................................... 67
  Using the default settings to copy a photo ......................................................................................................... 67
  Adjusting the settings and copying a photo ....................................................................................................... 68
  Changing the number of copies of a photo ......................................................................................................... 69
  Enlarging or reducing the size of a copy of a photo ......................................................................................... 70
  Darkening or lightening a copy of a photo ........................................................................................................ 71

8 Scanning

Before you begin scanning .................................................................................................................................. 72
  Changing the scan settings for scanning from the printer control panel .......................................................... 72
Loading originals for scanning ........................................................................................................................... 75
## Table of contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scanning from the printer control panel</td>
<td>75</td>
</tr>
<tr>
<td>Scanning to a computer</td>
<td>76</td>
</tr>
<tr>
<td>Scanning to a memory card or USB flash drive</td>
<td>77</td>
</tr>
<tr>
<td>Scanning to email</td>
<td>78</td>
</tr>
<tr>
<td>Scanning to network folder</td>
<td>79</td>
</tr>
<tr>
<td>Scanning from the computer</td>
<td>80</td>
</tr>
<tr>
<td>Scanning multiple pictures simultaneously</td>
<td>80</td>
</tr>
<tr>
<td>Scanning from the Online Printer Management Tool</td>
<td>82</td>
</tr>
</tbody>
</table>

### 9 Faxing

- Before you begin faxing                                             | 83   |
  - Connecting the printer for faxing                                 | 83   |
  - Entering fax sender information                                   | 87   |
  - Selecting fax settings                                             | 88   |
  - Working with the phonebook                                        | 92   |
- Preparing a fax for transmission                                     | 95   |
  - Printing a fax cover page                                         | 95   |
  - Loading originals for faxing                                      | 95   |
  - Setting fax option for one-sided or two-sided original            | 95   |
  - Changing resolution and brightness                                | 96   |
- Sending a fax                                                       | 97   |
  - Using the phonebook to send a fax                                 | 97   |
  - Using Quick Dial to send a fax                                    | 97   |
  - Using the numeric keypad to send a fax                            | 97   |
  - Using the Redial button to send a fax                             | 98   |
  - Sending a fax from your computer                                  | 98   |
- Receiving a fax                                                     | 99   |
  - Receiving a fax automatically                                     | 99   |
  - Receiving a fax manually                                           | 100  |
- Printing fax reports                                                | 100  |
  - Fax settings report                                                | 100  |
  - Fax confirmation page                                              | 101  |
  - Fax activity log                                                   | 101  |
  - Canceling a fax                                                    | 101  |

### 10 Maintaining Your Printer

- General care and cleaning                                           | 102  |
  - Cleaning the scanner glass and document backing                   | 103  |
- Replacing ink cartridges                                            | 105  |
- Replacing the printhead                                             | 108  |
- Updating the software and printer firmware                          | 112  |
  - Updating if your printer is connected to a computer with WINDOWS OS| 112  |
  - Updating if your printer is connected to a computer with MAC OS   | 113  |

[www.kodak.com/go/aiosupport](http://www.kodak.com/go/aiosupport)
### Table of contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Monitoring and adjusting printer performance</td>
<td>114</td>
</tr>
<tr>
<td>Checking ink levels</td>
<td>114</td>
</tr>
<tr>
<td>Checking paper levels</td>
<td>114</td>
</tr>
<tr>
<td>Resetting factory defaults</td>
<td>114</td>
</tr>
<tr>
<td><strong>11 Troubleshooting</strong></td>
<td></td>
</tr>
<tr>
<td>Basic troubleshooting</td>
<td>115</td>
</tr>
<tr>
<td>Getting help on the Web</td>
<td>117</td>
</tr>
<tr>
<td>Status lights</td>
<td>119</td>
</tr>
<tr>
<td>Power status light</td>
<td>119</td>
</tr>
<tr>
<td>Wi-Fi status light</td>
<td>119</td>
</tr>
<tr>
<td><strong>12 Product and Safety Specifications</strong></td>
<td></td>
</tr>
<tr>
<td>Features and Specifications</td>
<td>120</td>
</tr>
<tr>
<td>Print performance</td>
<td>120</td>
</tr>
<tr>
<td>Photo printing features</td>
<td>120</td>
</tr>
<tr>
<td>Copy document features</td>
<td>121</td>
</tr>
<tr>
<td>Copy photo features</td>
<td>121</td>
</tr>
<tr>
<td>Scanning features</td>
<td>121</td>
</tr>
<tr>
<td>Input paper tray</td>
<td>122</td>
</tr>
<tr>
<td>Output paper tray</td>
<td>122</td>
</tr>
<tr>
<td>Automatic document feeder (ADF) for originals</td>
<td>122</td>
</tr>
<tr>
<td>Fax system</td>
<td>122</td>
</tr>
<tr>
<td>Paper types supported</td>
<td>122</td>
</tr>
<tr>
<td>Paper sizes supported</td>
<td>123</td>
</tr>
<tr>
<td>Ink cartridges</td>
<td>124</td>
</tr>
<tr>
<td>Connectivity</td>
<td>124</td>
</tr>
<tr>
<td>Software support</td>
<td>124</td>
</tr>
<tr>
<td>Physical specifications</td>
<td>125</td>
</tr>
<tr>
<td>Warranty</td>
<td>125</td>
</tr>
<tr>
<td>System requirements</td>
<td>126</td>
</tr>
<tr>
<td>Safety information</td>
<td>127</td>
</tr>
<tr>
<td>LCD screen safety</td>
<td>128</td>
</tr>
<tr>
<td>Ink cartridge safety</td>
<td>128</td>
</tr>
<tr>
<td>Regulatory compliance</td>
<td>129</td>
</tr>
<tr>
<td>FCC statement</td>
<td>129</td>
</tr>
<tr>
<td>Canadian statements</td>
<td>130</td>
</tr>
<tr>
<td>European compliance statement</td>
<td>130</td>
</tr>
<tr>
<td>German compliance statement</td>
<td>130</td>
</tr>
<tr>
<td>REACH Article 33 declarations</td>
<td>131</td>
</tr>
<tr>
<td>Waste electrical and electronic equipment labeling</td>
<td>131</td>
</tr>
<tr>
<td>ENERGY STAR® Qualified</td>
<td>131</td>
</tr>
<tr>
<td>Warranty Information</td>
<td>132</td>
</tr>
<tr>
<td>Declaration of Conformity</td>
<td>133</td>
</tr>
</tbody>
</table>
Printer Overview

This printer lets you print, copy, scan, and fax pictures and documents. In addition, this printer supports networking, letting you access the printer over a wireless (Wi-Fi) or Ethernet network.

Components

1 Control panel
2 Automatic Document Feeder (ADF)
3 ADF paper-edge guides
4 Line in phone port
5 Ext out phone port
6 USB port (for connecting to computer)
7 Power cord port
8 Ethernet port
9 Rear-access cleanout area
10 Duplexer (pulled out)
11 Access door
12 Printhead with ink cartridges installed
13 Front USB port
14 Memory card slot
15 Paper tray
16 Scanner glass
17 Scanner lid
18 Output tray extender with paper stop
19 Output tray
## Control panel

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 LCD</td>
<td>Displays pictures, messages, and menus</td>
</tr>
<tr>
<td>2 Fax mode button</td>
<td>Lets you enter a phone number for sending a fax, or choose the Fax Options menu</td>
</tr>
<tr>
<td>3 Copy mode button</td>
<td>Displays the Copy Options menu</td>
</tr>
<tr>
<td>4 Navigation buttons</td>
<td>Used to navigate menus and scroll through pictures</td>
</tr>
<tr>
<td>5 OK button</td>
<td>Selects a menu item, accepts a setting, and continues with the current operation</td>
</tr>
<tr>
<td>6 Attention light</td>
<td>Blinks when an error occurs</td>
</tr>
<tr>
<td>7 Phonebook button</td>
<td>Displays the phonebook of fax numbers entered on this printer; lets you enter or edit phone numbers</td>
</tr>
<tr>
<td>8 Numeric keypad</td>
<td>Used to dial a phone number or a Quick Dial number for faxing; to enter information and Quick Dial settings into the fax phonebook; to specify a quantity for making copies; and to enter information for authenticating access to a network</td>
</tr>
<tr>
<td>9 Cancel button</td>
<td>Stops the current operation and returns to the menu; clears certain errors to allow scanning or sending a fax</td>
</tr>
<tr>
<td>10 Start Black button</td>
<td>Starts the selected operation in black and white</td>
</tr>
<tr>
<td>11 Power button</td>
<td>Turns the printer on or off</td>
</tr>
<tr>
<td>Feature</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>12 Wi-Fi status light</td>
<td>When lit, signals that the printer is connected to a wireless (Wi-Fi) network; blinks when searching for an available Wi-Fi network or when the existing signal is too weak to transmit or receive wireless signals</td>
</tr>
<tr>
<td>13 Start Color button</td>
<td>Starts the selected operation in color, if the source is in color</td>
</tr>
<tr>
<td>14 Redial button</td>
<td>Dials the last-dialed phone number</td>
</tr>
<tr>
<td>15 Auto Answer button</td>
<td>Turns the fax auto answer feature on or off; when the LED is on, the fax answers all incoming calls</td>
</tr>
<tr>
<td></td>
<td>with LED</td>
</tr>
<tr>
<td>16 Home button</td>
<td>Displays the main menu</td>
</tr>
<tr>
<td>17 Back button</td>
<td>Displays the next higher screen in the menu structure</td>
</tr>
<tr>
<td>18 Photo mode button</td>
<td>Displays the Print Photo Options menu</td>
</tr>
<tr>
<td>19 Scan mode button</td>
<td>Displays the Scan Options menu</td>
</tr>
</tbody>
</table>
Home Center Software

KODAK Home Center Software is installed with your KODAK All-in-One Printer Software, unless you choose otherwise. The Home Center icon will appear on your desktop.

NOTE: You can choose to install the KODAK AiO Printer Software Essentials, which include the drivers and Printer Tools only.

On a computer with WINDOWS Operating System (OS), you can use Home Center Software to:

- browse, crop, enhance, and edit pictures
- print and scan
- make 3D pictures (from picture pairs taken to create 3D pictures)
- print from video
- send images to or print images from KODAK Gallery
- send images to or print images from FACEBOOK Social Network, FLICKR, PHOTOBUCKET, PICASA, SMILEBOX Photo Management Systems, and Google Docs
- configure your printer
- install new network printers
- upgrade to the latest printer software and firmware
- order supplies
- access the KODAK Tips and Projects Center
- access the Online Printer Management Tool

On a computer with MAC OS, you can use Home Center Software to:

- scan
- configure your printer
- upgrade to the latest printer software and firmware
- order supplies
- see the status of your printer
- access the KODAK Tips and Projects Center
- access the Online Printer Management Tool
Ordering supplies

You can order ink cartridges, paper, and accessories online. An Internet connection is required.

To order supplies directly from Home Center Software:

1. Open Home Center Software.
2. Select **Order Supplies** (on a computer with WINDOWS OS) or select the **Tools** tab, then click **Order Supplies** (on a computer with MAC OS).
3. Select the item(s) you want to buy, then follow the on-screen instructions.

To order supplies directly from the Web:

- For ink, go to [www.kodak.com/go/printingsupplies](http://www.kodak.com/go/printingsupplies)
- For paper, go to [www.kodak.com/go/inkjetpaper](http://www.kodak.com/go/inkjetpaper)
Configuring printer settings

NOTE: When you first power on the printer, the LCD prompts you to select the Language and Country/Region.

To set or change basic printer settings:

1. Press Home.
2. Press ⬇ to select Printer Settings, then press OK.
3. Press ⬇ to select one of the following settings:
   - **Date and Time**
     - Press OK, then press ⬇ to select Year, Month, Day, Hour, or Minute.
     - Press ⬅ or ⬆ to change the values; press OK when you are done.
     - Press Back to return to the Printer Settings menu.
   - **Time to Low Power**
     To conserve energy, your printer will enter a low power (sleep) mode after being idle for a default delay time of 1 hour. You can increase the delay time to low power (in 0.5 hour increments) up to 4 hours. Increasing the delay time may result in reduced energy savings.
     - Press ⬆ to change the time to energy-saving sleep mode (select from 1 to 4 hours in 0.5 hour increments).
   - **Tagged Images Printing** (see Printing tagged pictures, page 55)
     - Press ⬆ to select Off or On.
   - **Language**
     - Press OK, press ⬇ to select a language, then press OK.
   - **Country/Region**
     - Press OK, press ⬇ to select a country or region, then press OK.
   - **Reset All Settings** (see Resetting factory defaults, page 114)
     NOTE: Resetting factory defaults does not change the date and time, language, country/region, or network settings.
   - **Printer Info**
     - Press OK to view the Firmware Version number; press OK when you are done.
4. Press Back to return to the Main Menu.
Networking Your Printer

This section explains how to configure or change your wireless network settings.

Connecting to a wireless network

To connect your printer to an 802.11b/g/n wireless (Wi-Fi) network, refer to the following information.

Before you connect

You need:

• a wireless router.
• to determine whether your wireless router supports Wi-Fi Protected Setup (WPS).

NOTE: If you have specific questions about your router, see your router manufacturer’s documentation for more information.

Connecting to a wireless network using the Wi-Fi Setup Wizard

You can use the Wi-Fi Setup Wizard on the printer to connect to your wireless network. Use the procedures that is appropriate for your network setup.

Connecting to a non-WPS wireless router

To connect your printer to your wireless network, you need to know the network name, also called the Service Set Identifier (SSID). You can obtain your network name from the wireless router. See the manufacturer’s documentation for more information.

If you have enabled security on your network, you also need to know the security string (passphrase or password), which may be a Wired Equivalent Privacy (WEP) or a Wi-Fi Protected Access (WPA/WPA2) passphrase.

Record your network information using the correct uppercase and lowercase letters.

Network Name (SSID): ______________________________________
Security String (case-sensitive): ________________________________

1. Press Home.
2. Press ▼ to select Network Settings, then press OK.
3. With Wi-Fi Setup Wizard selected, press OK.
   NOTE: The Wi-Fi radio turns on when you select Wi-Fi Setup Wizard.
The Wi-Fi connectivity LED blinks as the printer searches for available wireless networks within range, then displays the list in order of signal strength. For example:

If there are additional networks than can be shown on the LCD, press ▼ to view them.

4. Press ▼ to select your network name, then press OK.
   If you don’t see your network in the list, or if you want to change your network, select Rescan for Wireless Networks, then press OK.
   NOTE: If the name of your network is not listed, make sure your wireless router is turned on and within range.

5. If your network requires a password, use the LCD keyboard to enter your Security String. The Security String is case-sensitive.

6. When the confirmation message appears, press OK.
When the printer is successfully connected, the Wi-Fi connectivity LED will stop blinking and remains lit.

The printer with a wireless connection is listed as the name of the printer plus a number (for example, KodakOFFICEHERO6.1+1002).

7. If you haven’t yet installed the KODAK All-in-One Printer Software, insert the CD that came with the printer into the computer CD drive, and follow the on-screen instructions. When the software checks for updates, if a newer version exists, install the newer version. (On a computer with MAC OS, be sure to select the option to check for newer versions.)

NOTE: If you do not have the CD:
   a. Go to www.kodak.com/go/aiodownloads.
   b. In the results list, click the link for KODAK All-in-One Printer Software for your computer’s operating system.
   c. Follow the on-screen instructions.

Connecting to a WPS wireless router

If your router supports Wi-Fi Protected Setup (WPS), use WPS Connect. WPS lets you configure your printer for a wireless network by pressing buttons or entering a PIN.

To connect to a network using WPS:

1. Press Home.
2. Press ▼ to select Network Settings, then press OK.
3. With Wi-Fi Setup Wizard selected, press OK.
   NOTE: The Wi-Fi radio turns on automatically when you select Wi-Fi Setup Wizard.
4. With WPS Connect selected, press OK.
5. Select one of two methods of connecting:

**IMPORTANT:** Before you press **OK** on the printer, make sure you know where the router’s push button is, or where to enter the generated PIN. If necessary, consult your Internet Service Provider or router device manufacturer’s documentation for more information.

<table>
<thead>
<tr>
<th>Using Push Button Configuration</th>
<th>Entering WPS PIN</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>NOTE:</strong> You will have two minutes to press or select the WPS button. It may be a button on the device or a virtual button in the device’s software.</td>
<td>a. Press ▼ to select <strong>Generate WPS PIN</strong>, then press <strong>OK</strong>.</td>
</tr>
<tr>
<td>a. With <strong>Push Button Configuration</strong> selected, press <strong>OK</strong>.</td>
<td>b. In your wireless router’s software, locate the PIN screen, then follow the router’s instructions.</td>
</tr>
<tr>
<td>b. Press or select the WPS button for your wireless router.</td>
<td>c. Enter the PIN you received on the LCD into the PIN screen.</td>
</tr>
</tbody>
</table>

6. When the confirmation message appears, press **OK**.

When the printer is successfully connected, the Wi-Fi connectivity LED stops blinking and remains lit.

The printer with a wireless connection is listed as the name of the printer plus a number (for example, KodakOFFICEHERO6.1+1002).

7. If you haven’t yet installed the KODAK All-in-One Printer Software, insert the CD that came with the printer into the computer CD drive, and follow the on-screen instructions. When the software checks for updates, if a newer version exists, install the newer version. (On a computer with MAC OS, be sure to select the option to check for newer versions.)

**NOTE:** If you do not have the CD:

a. Go to www.kodak.com/go/aiodownloads.

b. In the results list, click the link for KODAK All-in-One Printer Software for your computer’s operating system.

c. Follow the on-screen instructions.
Setting up an IP Address

IMPORTANT: You should only need to set up an IP Address for your printer if you are having a problem connecting your printer to a wireless network. Typically, it is not necessary to set up an IP Address. This procedure is for advanced users.

All IP Address entries have the following format: 000.000.000.000. If an address or Subnet Mask has only one or two characters between the periods, include one or two leading zeros in front of that number. For example:

<table>
<thead>
<tr>
<th>The address as it may appear in your documentation</th>
<th>How to enter the address in the printer menu</th>
</tr>
</thead>
<tbody>
<tr>
<td>149.89.138.149</td>
<td>149.089.138.149</td>
</tr>
<tr>
<td>149.2.40.149</td>
<td>149.002.040.149</td>
</tr>
</tbody>
</table>

To set up your IP Address on the printer:

1. Press Home.
2. Press ▼ to select Network Settings, then press OK.
3. Press ▼ to select Advanced IP Address Setup, then press OK.
4. Press OK again to continue.
5. Select one of the following, then press OK:
   • Dynamic (DHCP)
   • Manual (Static)

6. If you selected Manual (Static), you are prompted to enter an IP Address, a Subnet Mask, a Gateway Address, and a DNS Server address. Press OK after each entry. Use the navigation buttons to enter each digit of the numbers. Consult your Internet Service Provider or network administrator for more information.
Viewing the network configuration

To view the network configuration and verify that you are connected to your wireless network:

1. Press Home.
2. Press ▼ to select Network Settings, then press OK.
3. Press ▼ to select View Network Configuration, then press OK.

The wireless or Ethernet network settings appear on the LCD, including:

• Printer Name
• Printer Hostname
• Connection
• Speed
• IP Address
• IP Address Type
• Network Subnet
• Connected Network SSID
• Security
• Authentication
• Channel
• Region
• Radio (on/off)
• MAC Address

If the printer is connected to your network, you will see the network name and the word CONNECTED.

4. To scroll through the information, press ▼.
5. When you are done, press OK.

Printing the network configuration

To print the current network configuration:

1. Load plain paper into the printer. (See Loading plain paper, page 40.)
2. Press Home.
3. Press ▼ to select Network Settings, then press OK.
4. Press ▼ to select Print Network Configuration, then press OK.
Installing your printer on additional computers on the network

To add your printer to another computer(s) on your network, install the KODAK All-in-One Printer Software on each computer.

- Insert the CD that came with the printer into the computer CD drive, and follow the on-screen instructions. When the software checks for updates, if a newer version exists, install the newer version. (On a computer with MAC OS, be sure to select the option to check for newer versions.)

NOTE: If you do not have the CD:
   a. Go to www.kodak.com/go/aiodownloads.
   b. In the results list, click the link for KODAK All-in-One Printer Software for your computer’s operating system.
   c. Follow the on-screen instructions.

Connecting to another KODAK All-in-One Printer

If you are connecting to a newer model printer (for example, you have an ESP OFFICE 6150 Printer and now you are adding an OFFICE HERO 6.1 Printer), you must install the KODAK All-in-One Printer Software for the newer model.

NOTE: When you install the new software, the printer driver for the ESP OFFICE 6150 Printer will be uninstalled, and updates for the ESP OFFICE 6150 Printer will be installed in addition to the driver for the OFFICE HERO 6.1 Printer.

On a computer with WINDOWS OS:

1. Select Start > All Programs > Kodak > KODAK Printer Setup Utility.
   - If your wireless printer (example: KodakOFFICEHERO6.1+1002) is not listed:
     a. Select No, my printer is not listed, then click Next.
     b. From the drop-down list, select your printer.
     c. Select Network - Wireless/Wi-Fi, then click Next.
        When your printer is detected, driver installation begins.
   - If your wireless all-in-one printer (example: KodakOFFICEHERO6.1+1002) is listed:
     a. Select the all-in-one printer that is connected to your network.
     b. Select Yes, my printer is listed, then click Next.
        When your printer is detected, driver installation begins.

2. When driver installation is complete, click Done.

On a computer with MAC OS:

1. Select Apple > System Preferences.
2. Under Hardware, select Print & Fax or Print & Scan.
3. Click + in the dialog box.
4. Select your printer from the list.
5. Click Add, if required.
Connecting to an Ethernet network

Before you connect, you need:

- an Ethernet network that includes a router, switch, or hub with an Ethernet port.
- a Category 5 (or higher) Ethernet cable.
- to temporarily disable your firewall until the printer is successfully installed and communicating.

To connect to an Ethernet network:

1. Connect the Ethernet cable to the Ethernet port on the back of the printer.

2. Connect the other end of the Ethernet cable to an available Ethernet port on your router, switch, or hub.

3. If you haven’t yet installed the KODAK All-in-One Printer Software, insert the CD that came with the printer into the computer CD drive, and follow the on-screen instructions. When the software checks for updates, if a newer version exists, install the newer version. (On a computer with MAC OS, be sure to select the option to check for newer versions.)

NOTE: If you do not have the CD:

a. Go to www.kodak.com/go/aiodownloads.

b. In the results list, click the link for KODAK All-in-One Printer Software for your computer’s operating system.

c. Follow the on-screen instructions.
Adding a wireless network connection to a USB-connected computer

You can change the way you connect to your printer at any time.

Changing from USB to a wireless connection

To change the printer connection type from USB to a wireless (Wi-Fi) network:

If your printer is connected to a computer with WINDOWS OS:

1. Disconnect the USB cable from your printer and computer.
2. On your computer, disable any firewall you have installed until you have successfully completed the installation.
3. If you have not already done so, connect your printer to your wireless network. See Connecting to a wireless network, page 7.
4. Select Start > All Programs > Kodak > KODAK Printer Setup Utility.
   • If your wireless all-in-one printer (example: KodakOFFICEHERO6.1+1002) is not listed:
     a. Select No, my printer is not listed, then click Next.
     b. Select your printer from the list.
     c. Select Network - Wireless/Wi-Fi, then click Next.
     When your printer is detected, driver installation begins.
   • If your wireless all-in-one printer (example: KodakOFFICEHERO6.1+1002) is listed:
     a. Select the all-in-one printer that is connected to your network.
     b. Select Yes, my printer is listed, then click Next.
     When your printer is detected, driver installation begins.
5. When driver installation is complete, click Done.

The printer with a wireless connection is listed as the name of the printer plus a number (for example, KodakOFFICEHERO6.1+1002).

If your printer is connected to a computer with MAC OS:

1. Disconnect the USB cable from your printer and computer.
2. If you have not already done so, connect your printer to your wireless network. See Connecting to a wireless network, page 7.
3. Select Apple > System Preferences.
4. Under Hardware, select Print & Fax or Print & Scan.
5. Click + in the dialog box.
6. Select your printer from the list.
7. Click Add, if required.

The printer with a wireless connection is listed as the name of the printer plus a number (for example, KodakOFFICEHERO6.1+1002).
Changing from USB to an Ethernet connection

Before you connect, you need:

- an Ethernet network that includes a router, switch, or hub with an Ethernet port.
- a Category 5 (or higher) Ethernet cable.
- to temporarily disable your firewall until the printer is successfully installed and communicating.

To change from a USB connection to an Ethernet network connection:

1. Disconnect the USB cable from your printer and computer.
2. Connect the Ethernet cable to the Ethernet port on the back of the printer.
3. Connect the other end of the Ethernet cable to an available Ethernet port on your router, switch, or hub.

If your printer is connected to a computer with WINDOWS OS:

1. Select Start > All Programs > Kodak > KODAK Printer Setup Utility.
2. Select No, my printer is not listed, then click Next.
3. Select KODAK OFFICE HERO 6.1 AiO from the printer list.
4. Select Network - Ethernet cable, then click Next.
   The Printer Setup Utility searches for your printer and connects automatically.
5. Click Done.

If your printer is connected to a computer with MAC OS:

1. Select Apple > System Preferences.
2. Under Hardware, select Print & Fax or Print & Scan.
3. Click + in the dialog box.
4. Select your printer from the list.
5. Click Add, if required.
The KODAK Online Printer Management Tool lets you access your printer through an Internet browser (such as INTERNET EXPLORER, FIREFOX, SAFARI, CHROME) on any computer that is on the same network as your printer.

**IMPORTANT:** Your computer and your printer must be on the same wireless or Ethernet network. The Online Printer Management Tool is not available if your printer is connected to a computer with only a USB cable.

With the Online Printer Management Tool, you can:

- view printer status
- configure (or change) printer settings
- change fax settings and add entries to the Fax phone book
- create Scan to Email and Scan to Network Folder profiles (that you can access from the printer control panel)
- add entries to the Email Address book
- set up accounts for GOOGLE Cloud Print and KODAK Email Print Service
Accessing the Online Printer Management Tool

Access the Online Printer Management Tool in one of the ways described below.

**Directly from Home Center Software v7.x or higher:**
1. Open Home Center Software.
2. Select **Printer Tools** on a computer with WINDOWS OS, or **Tools** on a computer with MAC OS.
3. Make sure that the name of your wirelessly connected printer appears in the bottom left of the window.
   
   NOTE: A wirelessly connected printer is listed as the name of the printer plus a number (for example, KodakOFFICEHERO6.1+1002). If a different printer name appears, click **Select**, then choose your wirelessly connected printer.

4. Under **Tools**, select **Online Printer Management**.
   The Online Printer Management Tool opens.

**On any printer-supported computer:**
1. Get the IP Address of your wirelessly connected printer:
   a. On your printer control panel, press **Home**.
   b. Press ◄ to select **Network Settings**, then press **OK**.
   c. Press ◄ to select **View Network Configuration**, then press **OK**.
   
   NOTE: If you prefer a printout, press ◄ to select **Print Network Configuration**, then press **OK**. A Test Page prints, including the IP Address in the format xxx.xxx.xxx.xxx.

   d. Press ◄ to see the IP Address in the format xxx.xxx.xxx.xxx. (See Viewing the network configuration, page 12.)

2. On your computer, open your preferred Internet browser (such as INTERNET EXPLORER, FIREFOX, SAFARI, CHROME).
3. Type the printer IP Address in the browser address (URL) bar, then press **Enter**.
   The Online Printer Management Tool opens in the browser window.
Using the Online Printer Management Tool

Configuring printer settings

To change the standby time, volume of the button sound, date and time, or reset the setting to the factory defaults:

1. Open the Online Printer Management Tool (see Accessing the Online Printer Management Tool, page 18).
2. Select the Settings tab.
3. Select Device in the left pane.
4. Select General, Date & Time, or Reset, and make any necessary changes.

5. Click Save. If you have reset any settings or profiles, click Reset.

NOTE: Select Reset to restore default settings, if necessary.
Changing the printer name

1. Open the Online Printer Management Tool (see Accessing the Online Printer Management Tool, page 18).
2. Select the Network tab.
3. Select General > Friendly Name.
4. Highlight the text in the Friendly name field and type the name you want, then click Save.

5. Click Save.
Adjusting fax settings

Edit your phone book, or change the fax settings.

Editing the fax phone book

To edit the fax phone book:

1. Open the Online Printer Management Tool (see Accessing the Online Printer Management Tool, page 18).
2. Select the Settings tab.
3. Select Fax > Phone Book.

To add a phone book entry:

1. Type the name and fax number, and, optionally, select a quick dial number for your fax entry.
2. Click Add.
To edit a phone book entry:
1. Select the check box for an existing entry in the **Phone Book**.
2. Click **Edit**.
3. Make the changes.
4. Click **Save**, then click **OK**.

To delete a phone book entry:
1. Select the check box for an existing entry in the **Phone Book**.
2. Click **Delete**, then click **Yes**.

**Changing fax settings**

To change fax settings:
1. Open the Online Printer Management Tool (see Accessing the Online Printer Management Tool, page 18).
2. Select the **Settings** tab.
3. Select **Fax > Settings**.
4. Enter the sender information.
   This information appears in the header of faxes you send from your printer.
   (For more information about sender information, see Entering fax sender information, page 87.)

5. Adjust fax any settings, as necessary. (For more information about settings, see Selecting fax settings, page 88.)

6. Click **Save**.

### Setting up Scan To Email

When you scan with your printer, you can send the scans directly from the printer to an email recipient. To do so, you must first set up a profile for yourself, and define the email address(es) to which you want to send scans.

#### Creating the outgoing email profile

1. Open the Online Printer Management Tool (see Accessing the Online Printer Management Tool, page 18).
2. Select the **Settings** tab.
3. Select **Scan To Email > Email Profile**.

4. Click **Add New Outgoing Email Profile**.
5. In the **Profile Name** field, type a name that has meaning to you; for example, your initials and your email provider, such as LR Hotmail or LR Gmail. This name will appear on the printer control panel when you start a scan to be sent through email.

6. In the **From Email Address** field, type your email address. Although the email will be sent from the printer, any replies will go to this email address.
7. Under Email Server Settings, enter your email service provider.
   • If your email service provider is Gmail, Yahoo, AOL, or Hotmail, select your services from the drop-down menu. The Email Service and Port Number fields fill in automatically.
   • If your email service provider is not in the drop-down menu:
     a. Type the email server name or the IP address of your email service provider in the Email Server field.
     b. Type the port number of your email server in the Port Number field.
     NOTE: Locate this information in the email account properties fields in your email application, or contact your Internet Service Provider.
     c. If your mail server supports secure connection mode, select the Always use secure connection check box.

8. If your email server requires authentication for sending emails:
   a. Select the The email server requires authentication for outgoing email check box.
   b. Type the User ID and Password for your email account.
9. If you want to limit who uses your profile (which appears on the printer LCD) to send scans:
   a. Select the **Enable Access PIN** check box.
   b. Type a 4-digit numeric **PIN** (your choice). You will need to enter this PIN each time you access your profile when scanning to an email address.

10. If you want a copies of all messages, select the **Copy sender for all email messages sent from the printer** checkbox.

11. Click **Test Profile** to confirm that the printer can access your account.
   - If the printer can access your account, “Test profile: Successful” appears. Click **OK**, then click **Save**.
   - If the printer cannot access your account, “Test Profile: Failed” appears. Click **OK**, then make changes to the profile.

### Setting up the email address book

To enter email addresses of people to whom to want to send scans by email:

1. Open the Online Printer Management Tool (see Accessing the Online Printer Management Tool, page 18).
2. Select the **Settings** tab.
3. Select **Scan To Email > Address Book**.
4. For each person:
   a. Type the person’s **Name**.
   b. Type the person’s **Email Address**.
   c. Click **Add**.
5. When you are finished adding email addresses, click **OK**.

**Setting options for scan to email**

When you send a scan to an email address, the printer uses defaults — subject line, body, and scan settings — that you set up under email options.

1. Open the Online Printer Management Tool (see Accessing the Online Printer Management Tool, page 18).
2. Select the **Settings** tab.
3. Select **Scan To Email > Email Option**.

4. Select and replace the default subject line and body text, if necessary. This subject line and body text will be included with every scan you send to an email address.
5. Select the scan settings that will be used for all scans sent to email.

**NOTE:** You can enter a Filename Prefix of your choice.

6. Click **Save**, then click **OK**.

You can now send a scan to an email address from the printer control panel. See **Scanning from the printer control panel**, page 75.
Setting up Scan To Network Folder

You can scan documents or photos directly to a file in a shared folder on your network.

Before you create a network folder profile

You must identify or create a network shared folder on a computer connected to the same network as your printer before you create a network folder profile. Note the network name of the folder, including the path information, and the name of the computer where it is located.

To learn more about sharing folders, see the information in the links below.

- For computers with WINDOWS XP OS, see www.microsoft.com/windowsxp/using/networking/maintain/share.mspx
- For computers with WINDOWS VISTA OS, see technet.microsoft.com/en-us/library/bb727037.aspx
- For computers with WINDOWS 7 OS, see windows.microsoft.com/en-US/windows7/File-sharing-essentials
- For computers with MAC OS 10.5 or later, see support.apple.com/kb/ht1549
Adding a network folder profile

To add a network folder profile that you can access from your printer control panel:

1. Open the Online Printer Management Tool (see Accessing the Online Printer Management Tool, page 18).
2. Select the Settings tab.
3. Select Scan To Network Folder > Network Folder Profile.
4. Click Add New Network Folder Profile.
5. Type:
   - **Profile Name**
   - **Folder Path**

6. If the computer where the folder is located requires authentication to access its shared folders, type the network login **User Name** and **Password**.

7. If you want to limit who uses your profile to scan documents to your network folder:
   a. Select the **Enable Access PIN** check box.
   b. Type a 4-digit numeric **PIN** (your choice). You will need to enter this PIN each time you access your profile when scanning to a network folder.

8. Click **Test Profile** to confirm that the printer can access the network folder.
   - If the printer can access the network folder, “Test profile: Successful” appears. Click **OK**, then click **Save**.
   - If the printer cannot access the network folder, “Test Profile: Failed” appears. Click **OK**, then make changes to the network folder profile.

You are now ready to scan a document or photo to your network folder from the printer control panel. See **Scanning from the printer control panel, page 75**.
Setting scan settings for scan to network folder

When you send a scan to network folder, the printer uses defaults that you set up under scan settings.

1. Select **Scan To Network Folder > Scan Settings**.

2. Select the scan settings that will be used for all scans sent to a network folder:
   
   NOTE: You can enter a Filename Prefix of your choice.

3. Click **Save**, then click **OK**.

You can now send a scan to a network folder from the printer control panel. See **Scanning from the printer control panel, page 75.**
Setting up Cloud Printing

Registering your printer with Google Cloud Print

Your printer lets you print from anywhere in the world using your smartphone, tablet, or computer that uses GOOGLE Cloud Print enabled apps. You must register your printer with a GOOGLE Account to enable this feature.

1. Make sure your printer and computer are connected to the same network (see Networking Your Printer, page 7).
2. Make sure you have the latest version of Home Center Software and printer firmware (see Updating the software and printer firmware, page 112).
3. Do one of the following:
   - Open Home Center Software, then click Cloud Printing Setup.
   - Depending on your Operating System, use the path below to select Cloud Printing Setup.
     - WINDOWS XP OS: Select Start > Programs > Kodak > KODAK AiO Printer Tools, then click Cloud Printing Setup.
     - WINDOWS VISTA and 7 OS: Select WINDOWS icon > All Programs > Kodak > KODAK AiO Home Center > Printer Tools, then click Cloud Printing Setup.
     - MAC OS: Select KODAK AiO Home Center > Tools, then click Cloud Printing Setup.
4. Follow the on-screen instructions.
5. Sign into your Google Account.
6. In the Google window, click Finish printer registration.
7. Return to the Online Printer Management Tool. Wait until you see Registration Successful for Google Cloud Print. This may take a few minutes.
8. To register your printer with KODAK Email Print Service and get an email address for your printer, go to step 3 of Registering your printer with KODAK Email Print Service, page 34.
9. Sign out of your Google Account.

For information about printing, see Printing using Google Cloud Print, page 58.
Editing a Google Cloud Print account

Once you have successfully created an account with Google, you can make edits to various fields.

1. Open the Online Printer Management Tool (see Accessing the Online Printer Management Tool, page 18).
2. Select the Settings tab.
4. Click Edit Settings.
5. Make the changes you want in the appropriate fields, then click Save.

Registering your printer with KODAK Email Print Service

KODAK Email Print lets you send emails and attachments to your printer using any email account. Your printer must be registered to Google Cloud Print before you can register to KODAK Email Print (see Registering your printer with Google Cloud Print, page 33). If you do not want to set up KODAK Email Print, you can access the set up at any time at www.kodakeprint.com.

2. Sign in with the account you used to set up Google Cloud Print (see Registering your printer with Google Cloud Print, page 33).
3. Click Get Email Address for KODAK Printer.
4. Click Allow Access.
   You will be redirected to the KODAK Email Print Service Web site.
5. Click Enable next to your printer.
6. To limit who can send emails to your KODAK Printer email address:
   a. Next to Access Control, click Edit.
   b. Select Control who can send email (by email or domain).
   c. To add a specific email address or domain, click Add new Email/Domain.
   d. Type the correct information for the email or domain, then click Save.
   NOTE: To delete an email or domain, click Delete.
Changing printer settings for copying and printing

You can change the default printer settings for copying documents and photos, and for printing photos.

Changing Copy Document and Copy Photo settings

To change the default printer settings for copying documents or photos:

1. Open the Online Printer Management Tool, (see Accessing the Online Printer Management Tool, page 18).
2. Select the Settings tab.
3. Select Copy & Print > Copy Documents or Copy Photo.
4. Make the changes you want in the appropriate fields, then click Save.
Changing Print Photo settings

To change the default printer settings for printing photos:
1. Open the Online Printer Management Tool (see Accessing the Online Printer Management Tool, page 18).
2. Select the Settings tab.
3. Select Copy & Print > Print Photo.
4. Make the changes you want in the appropriate fields, then click Save.
Handling Paper

For the best document printing results, use KODAK Document Papers or a paper with the COLORLOK Technology logo on the package. Use only paper that is designed for inkjet printers.

For the best photo printing results, use KODAK Photo Papers, which are optimized to work with KODAK All-in-One Printers, or photo papers designed for use on pigment-based inkjet printers.

When handling photo paper:

- Hold the paper by the edges; avoid placing your fingerprints on it.
- Do not touch the glossy side of photo paper.
- Store paper flat, away from direct sunlight and heat.

Paper types

You can use:

- Plain paper — 16 to 24 lb / 60 to 90 gsm
- Photo paper — 6.5 to 12 mils (up to 290 gsm)
- Card stock — 110 lb / 200 gsm, max
- Envelopes — 20 to 24 lb / 75 to 90 gsm
- Transparencies — inkjet variety with white stripe on short edge
- Labels — inkjet variety on 8.5 x 11-in. or A4 sheets
- Iron-on transfers — inkjet variety on 8.5 x 11-in. or A4 sheets
Paper sizes

The paper tray accepts the following paper sizes:

<table>
<thead>
<tr>
<th>Minimum size</th>
<th>Maximum size</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>English units</strong></td>
<td>4 x 6 in.</td>
</tr>
<tr>
<td><strong>Metric units</strong></td>
<td>10 x 15 cm</td>
</tr>
</tbody>
</table>

The paper tray accepts the following standard paper sizes:

- 4 x 6 in. / 10 x 15 cm
- 4 x 7 in. / 10 x 18 cm
- 4 x 8 in. / 10 x 20 cm
- 4 x 12 in. / 10 x 31 cm
- 5 x 7 in. / 13 x 18 cm
- 7.3 x 8.5 in. / 19 x 22 cm
- 7 x 10 in. / 18 x 25 cm
- US Executive (7.3 x 10.5 in. / 19 x 27 cm)
- 8 x 10 in. / 20 x 25 cm
- US Letter (8.5 x 11 in. / 22 x 28 cm)
- US Legal (8.5 x 14 in. / 22 x 36 cm)
- A4 (8.3 x 11.7 in. / 21 x 30 cm)
- A5 (5.8 x 8.3 in. / 15 x 21 cm)
- A6 (4.1 x 5.8 in. / 11 x 15 cm)
- B5 (6.9 x 9.8 in. / 18 x 25 cm)

NOTE: Do not load paper smaller than 4 x 6 in. / 10 x 15 cm.

Envelope sizes

The printer accepts the following envelope sizes:

- C5 (6.7 x 9 in. / 16 x 23 cm)
- C6 (4.5 x 6.4 in. / 11 x 16 cm)
- DL (4.3 x 8.7 in. / 11 x 22 cm)
- US #7¾ (3.9 x 7.5 in. / 10 x 19 cm)
- US #9 (3.9 x 8.9 in. / 10 x 23 cm)
- US #10 (4.1 x 9.5 in. / 10 x 24 cm)

IMPORTANT: Do not load envelopes with cutout or clear windows.
Loading paper

Loading plain paper

The capacity of the paper tray is 200 sheets of plain paper.

1. Raise the output tray, and pull out the paper tray.

2. Make sure the left paper-edge guide is to the far left.
3. Move the front paper-edge guide forward.

NOTE: When loading legal-size (8.5 x 14 in. / 22 x 36 cm) paper, move the front paper-edge guide forward until it is fully extended.
4. Fan and stack the paper, then insert it into the tray.
5. Move the paper forward until it stops.
6. Move both the left and front paper-edge guides until they touch the paper.

7. Push in the paper tray until it clicks into place, and lower the output tray.

8. Pull out the output tray extender until it is fully extended.
9. Lift the paper stop.

NOTE: When loading legal-size (8.5 x 14 in. / 22 x 36 cm) paper, move, do not lift the paper stop.
Loading photo paper

The capacity of the paper input tray is 70 sheets of photo paper.

1. Raise the output tray, and pull out the paper tray.

2. Remove any paper from the tray.

3. Insert the photo paper (short side first) into the tray with the logo side facing up and the glossy side down.

   IMPORTANT: Always load the paper short side first. The printer automatically detects the orientation of the picture, whether it's portrait or landscape, and prints accordingly. If the photo paper is loaded in the wrong direction, the image will be cut off and the paper may jam. If the paper is loaded with the wrong side up, the image quality will be affected.

4. Move the paper forward until it stops.

5. Move both the left and front paper-edge guides until they touch the paper.

6. Push in the paper tray until it clicks into place, and lower the output tray.
Loading envelopes

It is best to load envelopes one at a time.

IMPORTANT: Do not load envelopes with cutout or clear windows.

To load envelopes:
1. Raise the output tray, and pull out the paper tray.

   ![Diagram of Output Tray and Paper Tray]

2. Remove any paper from the tray.
3. Move the left paper-edge guide to the far left.
4. Move the front paper-edge guide forward.

   ![Diagram of Left and Front Paper-Edge Guides]
5. Insert the envelope(s) into the tray with the flap up and the top of the envelope against the right side of the tray.
6. Move both the left and front paper-edge guides until they touch the envelope(s).

7. Push in the paper tray until it clicks into place, and lower the output tray.

8. Pull out the output tray extender until it is fully extended
9. Lift the paper stop.
Loading originals

You can place originals for copying, scanning, or faxing on the scanner glass or in the ADF (Automatic Document Feeder). The ADF automatically feeds the originals into the printer when you begin copying, scanning, or faxing.

NOTE: Keep the scanner glass clean. Any dirt or smudges on the glass will appear as marks on the copy. See Cleaning the scanner glass and document backing, page 103.

Using the scanner glass

To place an original on the scanner glass:

1. Remove any originals from the Automatic Document Feeder (ADF).
2. Lift the scanner lid, and place the document or picture face down in the right-front corner.
3. Close the scanner lid.
Using the Automatic Document Feeder (ADF)

You can load up to 35 originals (20 to 24 lb / 75 to 90 gsm plain paper) in the Automatic Document Feeder (ADF).

The ADF accepts originals in the following sizes:

<table>
<thead>
<tr>
<th>Minimum size</th>
<th>Maximum size</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>English units</strong></td>
<td><strong>Metric units</strong></td>
</tr>
<tr>
<td>6.9 x 9.8 in.</td>
<td>176 x 250 mm</td>
</tr>
<tr>
<td>8.5 x 14 in.</td>
<td>216 x 356 mm</td>
</tr>
</tbody>
</table>

**IMPORTANT:** Do not load photographs, cards, or any paper stock heavier than 24 lb / 90 gsm or lighter than 16 lb / 60 gsm in the ADF.

1. Remove any originals from the scanner glass.
2. Open the ADF paper tray, and move the ADF paper-edge guides outward.
3. Fan and stack the originals, then insert them face up in the ADF, with the top of the pages in first.
   **IMPORTANT:** Remove all paper clips and staples from the originals.
4. Move the ADF paper-edge guides until they touch the paper.

The ADF automatically feeds the originals into the printer when you begin copying, scanning, or faxing.
5 Printing

Print documents and lab-quality pictures on your printer.

Printing documents

Printing one-sided documents

The default is for documents to print on one side of the paper.
To print a document from your computer:
1. Open the document.
2. Select File > Print.
3. In the Print dialog box, select your KODAK Printer.
4. Choose the pages to print, number of copies, etc, then click OK (on a computer with WINDOWS OS) or Print (on a computer with MAC OS).

Printing two-sided documents

You can print documents on both sides of the page automatically with the built-in duplexer or by manually by rotating and reloading the paper after the first side is printed.

IMPORTANT: Two-sided printing can only be done on media that can absorb ink on both sides, such as plain paper or two-sided photo paper. Two-sided printing will not work on bar-coded photo paper (the bar code is on the back side).

Printing two-sided documents automatically with the duplexer

Print documents on both sides of the page automatically with the built-in duplexer.

IMPORTANT: Automatic two-sided printing can only be done with letter/A4-sized plain paper.

Printing from a computer with WINDOWS OS

To print two-sided documents automatically from a computer with WINDOWS OS:
1. Load plain paper into the paper tray.
2. Open the document you want to print, then select File > Print.
3. In the Print dialog box, make sure that KODAK OFFICE HERO 6.1 AiO (or for a wireless connection, KODAK OFFICE HERO 6.1 +XXXX, where XXXX is a number) is selected, then click Properties or Preferences.
4. Select the Layout tab.
5. In the Two-sided printing field, select Automatically with Duplexer, then click OK.
   NOTE: You can also select automatic two-sided printing from the General tab under the Job settings field.
6. Under Flip on, select either Long edge or Short edge.
7. Click OK or Print to start printing.
Printing from a computer with MAC OS

To print two-sided documents automatically from a computer with MAC OS:

1. Load plain paper into the paper input tray.
2. Open the document you want to print, then select File > Print.
3. In the Print dialog box, make sure that Eastman Kodak Company KODAK OFFICE HERO 6.1 AiO printer (or for a wireless connection, KODAK OFFICE HERO 6.1 +XXXX, where XXXX is a number) is selected.
4. In the Copies & Pages drop-down list, select Layout.
5. In the Two-Sided drop-down list, select either Long-Edge binding or Short-Edge binding.
6. Click Print.

Printing two-sided documents manually

You can print two-sided documents on any size paper that the printer accepts from a minimum of 4 x 6 in. / 10 x 15 cm to a maximum of 8.5 x 14 in / 22 x 36 cm (see Paper sizes, page 39) when you rotate the paper manually when prompted by the printer.

IMPORTANT: Two-sided printing can only be done on media that can absorb ink on both sides, such as plain paper or two-sided photo paper. Two-sided printing will not work on bar-coded photo paper (the bar code is on the back side).

Printing from a computer with WINDOWS OS

To print two-sided documents manually from a computer with WINDOWS OS:

1. Load paper into the paper tray.
2. Open the document you want to print, then select File > Print.
3. In the Print dialog box, make sure that KODAK OFFICE HERO 6.1 AiO (or for a wireless connection, KODAK OFFICE HERO 6.1 +XXXX, where XXXX is a number) is selected, then click Properties or Preferences.
4. Select the Layout tab.
5. In the Two-sided printing field, select Manual (Instructions provided), then click OK.
   NOTE: You can also select manual two-sided printing from the General tab under the Job settings field.
6. Under Flip on, select either Long edge or Short edge.
7. Click OK or Print.
8. When a message appears on your computer or printer LCD, remove the printed pages from the output tray.
9. Rotate the printed pages 180 degrees, and place them into the paper tray (printed side up).
10. Press **Start Black** or **Start Color** on the printer.
    NOTE: It does not matter which **Start** button you press; the print job will continue printing in either color or black, depending on the document.

**Printing from a computer with MAC OS**

To print two-sided documents manually from a computer with MAC OS:

1. Load paper into the paper tray.
2. Open the document you want to print, then select File > Print.
3. In the Print dialog box, make sure that Eastman Kodak Company KODAK OFFICE HERO 6.1 AiO printer (or for a wireless connection, KODAK OFFICE HERO 6.1 +XXXX, where XXXX is a number) is selected.
4. In the Print dialog box, select the **two-sided** check box.
5. Click **Print**.
6. When the even-numbered pages have finished printing, follow the instructions on the printer LCD to reload the printed pages in the paper tray.
7. Press **Start Black** or **Start Color** on the printer control panel to print the odd-numbered pages.
    NOTE: It does not matter which **Start** button you press; the print job will continue printing in either color or black-and-white, depending on the document.

**Printing forms from the control panel**

You can print the following forms from the control panel:

- Graph Paper
- Wide Ruled
- Narrow Ruled
- Grocery List
- Reminder List
- Tic-tac-toe
- Sheet Music (Portrait)
- Sheet Music (Landscape)

To print a preprogrammed form:

1. Press **Home**.
2. Press ▼ to select **Printable Forms**, then press **OK**.
3. Press ▼ to select a form.
4. Press ◀ or ▶ to select a quantity (up to 99), then press **OK**.
5. Press **Start Black** or **Start Color** on the printer.
    NOTE: It does not matter which **Start** button you press; the form will print in either color or black, depending on the form.
Printing pictures

You can print pictures with your all-in-one printer from:

- A memory card inserted into a memory card slot
- A storage device (such as a flash drive) or camera connected to the front USB port with a USB cable
- An iPhone, iPod touch, iPad, BLACKBERRY Device, or ANDROID OS Device (may not be available with all models). For more information, go to www.kodak.com/go/mobile.

You can also print pictures using Home Center Software from your computer with WINDOWS OS. Home Center Software lets you edit and enhance your pictures quickly. Open Home Center Software, select Edit and Print Pictures, then follow the on-screen instructions.

On a computer with MAC OS or WINDOWS OS, you can print pictures from KODAK EASYSHARE Software or any picture-editing or photo-management software.

Viewing pictures on a memory card or USB-connected device

When you insert a memory card into the memory card slot on your printer or connect a USB device to the front USB port, the pictures appear on the LCD. Press ◀ or ▶ to scroll through the pictures.

If the printer is idle for more than two minutes, the LCD will revert to the status display. To view the pictures again, press any button, then press ◀ or ▶.

Finding pictures on a memory card or USB-connected device

Your printer can help you locate pictures on a memory card or USB-connected device by the date the picture was taken or last saved.

To locate pictures:

1. Insert the memory card into the memory card slot or connect the USB device to the front USB port.
2. Press Home.
3. Press ▼ to select View and Print Photos, then press OK.
4. Press ▼ to select Find Photos, then press OK.
5. In the View by Date menu, press ▼ to select Year, Month, and/or Day; press ◀ or ▶ to select the specific year, month, and/or day.
   The number of photos found for the date you specified appears under the menu name.
6. To view these pictures, press OK.
Printing from a memory card or USB-connected device

You can print pictures from the following cards or USB-connected devices:

<table>
<thead>
<tr>
<th>MS/XD/SD Card slot</th>
<th>Front USB port</th>
</tr>
</thead>
<tbody>
<tr>
<td>• MULTIMEDIA Card (MMC)</td>
<td>• PICTBRIDGE Technology enabled camera</td>
</tr>
<tr>
<td>• XD Picture Card</td>
<td>• Flash drive</td>
</tr>
<tr>
<td>• SECURE DIGITAL (SD) Card</td>
<td>• MSC Cameras (cameras as USB storage device)</td>
</tr>
<tr>
<td>• SECURE DIGITAL High Capacity (SDHC) Card</td>
<td></td>
</tr>
<tr>
<td>• Variations of the memory cards above that require an adapter (for example, MEMORY STICK Duo, miniSD, microSD, and T-Flash)</td>
<td></td>
</tr>
</tbody>
</table>

IMPORTANT: If you use a memory card with an adapter, make sure you insert and remove the adapter and the memory card as a unit; do not remove the memory card while leaving the adapter in the printer.
Using default settings to print a picture

Unless you change the default settings, the default for printing pictures is one 4 x 6 in. / 10 x 15 cm picture. (To change the default settings, see Save as Defaults at the bottom of the table under Changing the settings and printing pictures, page 53.)

To print a picture from a memory card or USB-connected device using the default settings:

1. Load photo paper (see Loading photo paper, page 42).
2. Insert the memory card into the appropriate slot, or connect the digital camera or portable drive to the front USB port.

   IMPORTANT: Do not use the memory card slot and the USB port at the same time.

3. Press \ or \ to select the picture you want to print.
4. Press **Start Black** to print a black-and-white picture, or **Start Color** to print a color picture.

   The printer prints a single 4 x 6 in. / 10 x 15 cm picture.

   IMPORTANT: To prevent loss of data from your memory card, camera, or portable drive, do not remove it from the printer while printing.
Changing the settings and printing pictures

You can change the print photos options for an individual picture or group of pictures, or you can change the settings and save them as the default.

To print a picture or pictures using settings other than the default settings:

1. Insert the memory card into the memory card slot, or connect the digital camera or portable drive to the front USB port. A picture appears on the LCD.

   IMPORTANT: Do not use the memory card slot and the USB port at the same time.

2. Press or to find the picture you want to print, then press OK.
3. Repeat step 3 for each picture you want to print.
5. Press to select an option (see table below), then press or to change the setting.

<table>
<thead>
<tr>
<th>Print Photos Option</th>
<th>Settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>View Photos</td>
<td>--</td>
<td>Scroll through the pictures on the memory card; press OK to select the picture for printing; press Back to display the Print Photos Options menu.</td>
</tr>
<tr>
<td>Find Photos</td>
<td>--</td>
<td>Press OK, then select a year, month, and/or day to view photos by the date that they were taken; press OK to view the photo(s); press Back to display the Print Photos Options menu.</td>
</tr>
<tr>
<td>Print Photos Option</td>
<td>Settings</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>----------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Transfer All to PC</td>
<td>--</td>
<td>Your printer and computer must be connected with a USB cable. To transfer all the pictures on the memory card to your computer, press OK then press <strong>Start Black</strong> or <strong>Start Color</strong>. (It does not matter which <strong>Start</strong> button you press.)</td>
</tr>
<tr>
<td>Rotate This Photo</td>
<td></td>
<td>Press <strong>OK</strong> to rotate the selected photo, then press ← or → or for the direction in which to rotate.</td>
</tr>
<tr>
<td>Quantity</td>
<td>1 (default) to 99</td>
<td>The number of copies that print.</td>
</tr>
<tr>
<td>Print Size</td>
<td>2 x 3, 3.5 x 5, 4 x 6 (default), 4 x 7, 4 x 8, 5 x 7, 4 x 12, 7 x 10, 8 x 10, 8.5 x 11 or A4</td>
<td>If the selected print size is smaller than the paper in the paper tray, the printer automatically arranges the pictures to best fit the paper size.</td>
</tr>
<tr>
<td>Plain Paper Quality</td>
<td>Normal (default), Best, Draft</td>
<td>Good quality output; prints faster than Best. The highest quality, but the slowest print speed. The fastest print speed, but the lowest quality.</td>
</tr>
<tr>
<td>Photo Paper Quality</td>
<td>Auto. (default)</td>
<td>The printer detects when you load photo paper and sets Best quality automatically.</td>
</tr>
<tr>
<td>Scene Balance</td>
<td>On (default), Off</td>
<td>Adjusts the image brightness to correct for underexposure and reduces the variation in contrast in different areas of the picture.</td>
</tr>
<tr>
<td>Add Date to Prints</td>
<td>No (default), Yes</td>
<td>Prints the date the picture was taken or last edited in a corner of the print.</td>
</tr>
<tr>
<td>Save as Defaults</td>
<td>No / Yes</td>
<td>To save the settings as the new default, press <strong>OK</strong>. With <strong>Yes</strong> selected, press <strong>OK</strong>.</td>
</tr>
</tbody>
</table>

**NOTE:** You can also adjust the print photo settings using the Online Printer Management Tool. When viewing the tool in your browser (see **Accessing the Online Printer Management Tool, page 18**), select the **Settings** tab, then select **Copy & Print > Print Photo**.
6. When you have finished changing settings, press Start Black to print a black-and-white picture, or Start Color to print a color picture.

IMPORTANT: To prevent loss of data from your memory card, camera, or portable drive, do not remove it from the printer while printing.

**Printing tagged pictures**

Some digital cameras let you tag (or “mark”) pictures on the memory card for printing. This creates a tag that is recognized by the printer. If you choose to print tagged pictures, they will print according to the default settings on your printer (unless otherwise specified by the tag from the camera).

NOTE: Refer to your camera user guide to determine whether your camera supports tagged pictures (may also be called “marked” or “DPOF”) functionality.

To print tagged pictures:

NOTE: Make sure Tagged Images Printing is On (see Configuring printer settings, page 6).

1. Insert the memory card into the memory card slot or connect a camera to the front USB port.

2. When the “Print tagged images?” message appears, press Start Black to print a black-and-white picture, or Start Color to print a color picture.
Printing panoramic pictures

To print a panoramic picture, load 4 x 12 in. / 10 x 31 cm paper, or US letter or A4 paper in the paper tray.

1. Insert the memory card into the memory card slot, or connect a camera or storage device (such as a flash drive) to the front USB port.

2. Press \( \downarrow \) or \( \uparrow \) to find the panoramic picture you want to print, then press \textbf{OK}.
4. Press \( \downarrow \) to select \textbf{Print Size}, then press \( \uparrow \) to select \textbf{4 x 12}.
5. Press \textbf{Start Black} to print a black-and-white picture, or \textbf{Start Color} to print a color picture.

\textbf{IMPORTANT}: To prevent loss of data from your memory card, camera, or portable drive, do not remove it from the printer while printing.

Printing from a wireless device

You can print pictures wirelessly at the touch of a button from:

- iPhone (iOS 3.0 or later)
- iPod touch (2nd generation)
- iPad
- BLACKBERRY Device (software v4.5 or later)
- a device running ANDROID OS v2.0 or later

For more information, see \textit{Mobile Printing, page 58}. 
Transferring pictures to a computer

You can transfer your pictures from a memory card in the printer or from a USB-connected device to your computer. To transfer these files, the printer must be connected to your computer with a USB cable.

NOTE: If you have large video files or a large number of pictures (400 or more), we recommend that you transfer them using a memory card reader attached directly to your computer.

Transferring pictures to a computer with WINDOWS OS

1. Insert the memory card into the memory card slot on the printer, or connect a digital camera or USB flash drive to the front USB port.
2. Press Back.
3. Press ▼ to select Transfer All to PC, then press OK.
4. Press Start Black or Start Color.
   NOTE: It does not matter which Start button you press.
5. If your computer is connected to a wireless network and with a USB cable, select the USB-connected printer (no number after the printer name).
6. Follow the on-screen instructions on your computer.

Transferring pictures to a computer with MAC OS

1. Insert the memory card into the memory card slot on the printer, or connect a digital camera or USB flash drive to the front USB port.
2. Press Back.
3. Press ▼ to select Transfer All to PC, then press OK.
4. Press Start Black or Start Color.
   NOTE: It does not matter which Start button you press.
5. If your computer is connected to a wireless network and with a USB cable, select the USB-connected printer (no number after the printer name).
6. Use iPhoto or Image Capture on your computer to complete the transfer.

NOTE: You can also adjust the print photo settings using the Online Printer Management Tool. When viewing the tool in your browser (see Accessing the Online Printer Management Tool, page 18), select the Settings tab, then select Copy & Print > Print Photo.
Mobile Printing

Mobile printing lets you print to your all-in-one printer from your Web-connected mobile device.

When your:

• printer is registered to Google Cloud Print, you can print from anywhere with your mobile device using Google Cloud Print apps.
• printer has an email address (assigned by KODAK Email Print Service), you can send emails and email attachments to your printer from anywhere, from a device capable of sending email.
• mobile device is connected to the same wireless network as your printer, you can print pictures using a KODAK Pic Flick App.

When you plan to use mobile printing, make sure that your printer power is on or your printer is in low power mode (for information, see Time to Low Power under Configuring printer settings, page 6.

Printing using Google Cloud Print

Print on the go from your smartphone, computer, or tablet using Google Cloud Print enabled apps.

Before you can use Google Cloud Print, make sure your printer is set up for Google Cloud Print. See Setting up Cloud Printing, page 33.

Printing varies by application. For the latest update, go to www.google.com/cloudprint/learn/apps.html.

To print from a Chromebook:

Click the wrench and select Print to print the Web page you are viewing (you can also use the keyboard shortcut Ctrl+P).

To print from an iOS mobile device (iPhone, iPad, iPod touch):

• From GMAIL:
  − Email body: Select the email, then click the menu in the top-right corner and select Print.
  − Attachment: Click the Print button next to the attachment.
• From Google Docs:
  − Select the document, then click the menu in the top-right corner and select Print.

To print from an ANDROID OS Device:

Install the Google Cloud Print App from the ANDROID Market.
**To print from a computer:**

Install the Chrome extension (plug in) from the Chrome Web store, then:

- From GMAIL:
  - Email body: Select the email, then click the **Print all using Google Cloud Print** link at the top right of the email.
  - Attachment: Select **Print attachment using Google Cloud Print**.

- From Google Docs:
  - Select **File > Print using Google Cloud Print**.

- Web pages (URL must end with .pdf, .doc, or .txt):
  - Click **Print using Google Cloud Print** when it appears on the URL address bar.
  - For the latest information on supported formats, go to the Chrome extension (plug in) Web site.

**To print from a BLACKBERRY OS Device:**

We recommend you use KODAK Email Print.

---

**Printing using KODAK Email Print Service**

**Printing emails, documents, and pictures**

KODAK Email Print lets you send emails and email attachments (documents and pictures) to your printer from anywhere, using any device capable of sending email.

**NOTE:** Before you can use KODAK Email Print, your printer must be registered to Google Cloud Print (see Setting up Cloud Printing, page 33), and your printer must have an email address assigned by KODAK Email Print (see Registering your printer with KODAK Email Print Service, page 34).

To print using KODAK Email Print:

1. Make sure that your device or computer is connected to the Internet.
2. Open an email application (such as GMAIL, MICROSOFT OUTLOOK, HOTMAIL, YAHOO, iOS Mail, ANDROID OS Mail).
3. Write your email and attach the file(s) you would like to print.
4. Send the email to your printer email address.

   The email body and attachments will print to your printer.

**NOTE:** If your printer has a photo paper tray, .jpg files attached to your email will automatically print to the photo paper tray, and documents will print to the main paper tray.
Printing pictures from a mobile device

When connected to the same Wi-Fi network, you can print pictures wirelessly with your all-in-one printer from:

- an iPhone (iOS 3.0 or later), iPod touch device (2nd generation), iPad (may not be available with all models).
- a BLACKBERRY Device (software v4.5 or later).
- a device running ANDROID OS v2.0 or later.

Download the KODAK Pic Flick App from the App Store directly from your device, then follow the procedure for your device. For information, go to www.kodak.com/go/mobile.

Printing pictures from an iPhone, iPad, or iPod touch device

IMPORTANT: Requires iOS 3.0 or later.

To print a picture from an iPhone, iPad, or iPod touch device (2nd generation):

1. Make sure your device is connected to the same Wi-Fi network as your printer.
2. Open the KODAK Pic Flick application on your device.
3. Select the picture(s) you want to print, then select Choose Device.
4. Select your KODAK All-in-One Printer from the list of available devices.
5. Select Send.

Printing pictures from a BLACKBERRY Device

To print a picture from a BLACKBERRY Device (software v4.5 or later):

1. Make sure your BLACKBERRY Device is connected to the same Wi-Fi network as your printer.
2. Open the KODAK Pic Flick application on your device.
3. Select the picture(s) you want to print.
4. Press the Menu key, then select Print.
5. Select your KODAK All-in-One Printer from the list of available devices.
   NOTE: It may take a few minutes for the printer to appear in the Available Printers list.

6. Select the print size and enter the number of copies.
7. Select Print.
Printing pictures from an ANDROID OS Device

To print a picture from a device running ANDROID OS v2.0 or later:

1. Make sure your device is connected to the same Wi-Fi network as your printer.
2. Open the KODAK Pic Flick application on your device.
3. Select the picture(s) you want to print.
4. Select View/Edit to edit the picture(s), or go to step 5.
   a. Press and hold the screen to enter the edit mode.
   b. Rotate, move, pan, zoom, or crop the picture.
5. Press Select Device, then select your KODAK All-in-One Printer.
6. Select the print size.
7. Press Back, then select Send.
7 Copying

You can copy documents and photographs with your all-in-one printer. The printer produces high-quality color or black-and-white copies on a variety of paper types (see Paper types, page 38).

Loading originals for copying

You can copy multiple-page, one- or two-sided documents automatically by loading the originals (up to 35 pages) face up in the Automatic Document Feeder (ADF).

IMPORTANT: The ADF accepts plain paper originals from 6.9 to 8.5 in. (18 to 22 cm) wide and 9.8 to 14 in. (25 to 36 cm) long.

To copy a photo, documents on thick paper, or a document that is too small or too large to fit in the ADF, place the original face down on the scanner glass.

For more information on loading originals, see Loading originals, page 45.

Copying a document

You can copy a document using the default settings, or you can adjust the quantity, size, quality, and brightness of your copies.

Using the default settings to copy a document

The default settings are either the factory default settings (see Resetting factory defaults, page 114), or defaults that you have set on the printer (see Save as Defaults at the bottom of the table under Adjusting the settings and copying a document, page 63).

To copy a document using the current default settings:

1. Place the original document in the ADF or on the scanner glass.
2. Press Copy.
3. Press Start Black to make a black-and-white copy, or press Start Color to make a color copy.

NOTE: If you load the original document in the ADF, the ADF automatically feeds the document into the printer when you begin copying.
**Adjusting the settings and copying a document**

To copy a document using settings other than the default settings:

1. Place the original document in the ADF or on the scanner glass.
2. Press **Copy**.
   
   The Copy Document Options menu appears on the LCD.
3. Press ‹ or † to select an option, then press ‹ or † to change the setting.

<table>
<thead>
<tr>
<th>Copy Document Option</th>
<th>Settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Quantity</td>
<td>1 (default) to 99</td>
<td>The number of copies that print.</td>
</tr>
<tr>
<td>Original</td>
<td>1-sided</td>
<td>The information you want to copy is on one side of the page.</td>
</tr>
<tr>
<td></td>
<td>2-sided*</td>
<td>The information you want to copy is on both sides of the page.</td>
</tr>
</tbody>
</table>

* You must load 2-sided originals in the ADF (see **Using the Automatic Document Feeder (ADF), page 46**)

| Output | 1-sided | The copy is printed on one side of the page. |
|        | 2-sided | The copy is printed on both sides of the page. |

| Copy Size       | Same Size (default) | The copy is the same size as the original. |
|                | Fit to Page         | The printer detects the size of the original on the scanner glass and the size of the paper in the paper tray, and automatically reduces or enlarges the original so that the copy fits on the paper. |
|                | 20% to 500%         | Reduces up to 20% or enlarges up to 500% of the original size. |

| Plain Paper Quality | Normal (default) | Good quality output; prints faster than Best. |
|                     | Best             | The highest quality, but the slowest print speed; eliminates the banding effect that sometimes occurs. |
|                     | Draft            | The fastest print speed, but the lowest quality. |
4. Press **Start Black** to make a black-and-white copy, or press **Start Color** to make a color copy.

### Changing the number of copies of a document

To change the number of copies:

1. Place the original document in the automatic document feeder (ADF) or on the scanner glass.
2. Press **Copy**.
   
   The Copy Document Options menu appears on the LCD.
3. Make sure **Quantity** is selected.
4. Press ‹ or › to select a number, or use the numeric keypad to enter the number of copies.
5. Press **Start Black** to make black-and-white copies, or press **Start Color** to make color copies.

### Enlarging or reducing the size of a copy

To enlarge or reduce the size of the copy:

1. Place the original document in the automatic document feeder (ADF) or on the scanner glass.
2. Press **Copy**.

   The Copy Document Options menu appears on the LCD.
3. Press ‹ to select **Copy Size**.
4. Press ‹ or › to select an enlargement or reduction.
5. Press **Start Black** to make a black-and-white copy, or press **Start Color** to make a color copy.

---

**Copy Document Option** | **Settings** | **Description**
--- | --- | ---
Photo Paper Quality | Auto. (default) | The printer detects photo paper in the paper tray and sets Best quality automatically.
Brightness | Normal, -3 to +3 (Normal is default) | Lightens or darkens the copy. Normal is no change from the original; -3 is the darkest; +3 is the lightest.
Save as Defaults | No / Yes | To save the settings as the new default, press **OK**. With **Yes** selected, press **OK**.
Darkening or lightening a copy

To darken or lighten the copy:

1. Place the original document in the automatic document feeder (ADF) or on the scanner glass.
2. Press Copy.
   The Copy Document Options menu appears on the LCD.
3. Press ▼ to select Brightness.
4. Press ▼ to select a number below zero for a darker copy, or press ▼ to select a number above zero for a lighter copy.
5. Press Start Black to make a black-and-white copy, or press Start Color to make a color copy.

Two-sided copying

Automatic two-sided copying

With the built-in duplexer and the automatic document feeder (ADF), you can make two-sided copies of your documents automatically. You have the following options for two-sided copying:

- one-sided original to two-sided copy
- two-sided original to two-sided copy
- two-sided original to one-sided copy

IMPORTANT: Both the original and the copy must be on either letter or A4-sized plain paper.

To copy a document:

1. Load plain paper into the paper tray, if necessary.
2. Place your original document (up to 35 pages) in the ADF (see Using the Automatic Document Feeder (ADF), page 46).
3. Press Copy.
   The Copy Document Options menu appears on the LCD.
4. Press ▼ to select Original, then press ▼ to select 1-sided or 2-sided, depending on your original(s).
5. Press ▼ to select Output, then press ▼ to select 1-sided or 2-sided.
6. Press Start Black to make a black-and-white copy, or press Start Color to make a color copy.
Manual two-sided copying

If the original is not on letter or A4-sized plain paper, or if you want the copy to be on paper other than letter or A4-sized plain paper, you can make two-sided copies manually.

To make a two-sided copy:

1. Load the paper into the paper tray.
2. Place your original on the scanner glass (see Using the scanner glass, page 45).
3. Press **Copy**.
   The Copy Document Options menu appears on the LCD.
4. If necessary, press ▼ to make changes to copy size, quality, or brightness.
5. Press **Start Black** to make a black-and-white copy, or press **Start Color** to make a color copy.
6. Remove the printed page from the output tray and rotate it 180 degrees, then place the page into the paper tray (printed side up).
7. Place the next original on the scanner glass.
8. If necessary, press ▼ to make changes to copy size, quality, or brightness.
9. Press **Start Black** to make a black-and-white copy, or press **Start Color** to make a color copy.
Copying a photo

You can copy a photo using the default settings, or you can make adjustments to the quantity, size, quality, and brightness of your copies.

Using the default settings to copy a photo

The default settings are either the factory default settings (see Resetting factory defaults, page 114), or defaults that you have set on the printer (see Save as Defaults at the bottom of the table under Adjusting the settings and copying a photo, page 68).

To copy a photo using the current default settings:

1. Lift the scanner lid, and place the original photo face down in the right front corner of the scanner glass.

   IMPORTANT: Do not load photos in the Automatic Document Feeder (ADF).

2. Close the scanner lid.
4. Press ▼ to select Copy Photo.
5. Press Start Black to make a black-and-white copy, or press Start Color to make a color copy.
Adjusting the settings and copying a photo

To copy a photo using settings other than the default settings:

1. Lift the scanner lid, and place the original photo face down in the right front corner of the scanner glass.

IMPORTANT: Do not load photos in the Automatic Document Feeder (ADF).

2. Close the scanner lid.
4. Press ▼ to select Copy Photo, then press OK.
5. Press ▼ to select an option, then press ▼ or ▲ to change the setting.

<table>
<thead>
<tr>
<th>Copy Photo Option</th>
<th>Settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Quantity</td>
<td>1 (default) to 99</td>
<td>The number of copies that print.</td>
</tr>
<tr>
<td>Copy Size</td>
<td>2 x 3</td>
<td>The printer enlarges or reduces the original to make it the copy size you select.</td>
</tr>
<tr>
<td></td>
<td>3.5 x 5</td>
<td>If the selected copy size is smaller than the paper in the paper tray, the printer automatically arranges the pictures to best fit the paper size.</td>
</tr>
<tr>
<td></td>
<td>4 x 6 (default)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>4 x 7</td>
<td></td>
</tr>
<tr>
<td></td>
<td>4 x 8</td>
<td></td>
</tr>
<tr>
<td></td>
<td>5 x 7</td>
<td></td>
</tr>
<tr>
<td></td>
<td>4 x 12</td>
<td></td>
</tr>
<tr>
<td></td>
<td>8 x 10</td>
<td></td>
</tr>
<tr>
<td></td>
<td>8.5 x 11 or A4</td>
<td></td>
</tr>
<tr>
<td>Plain Paper Quality</td>
<td>Normal (default)</td>
<td>Good quality output; prints faster than Best.</td>
</tr>
<tr>
<td></td>
<td>Best</td>
<td>The highest quality, but the slowest print speed.</td>
</tr>
<tr>
<td></td>
<td>Draft</td>
<td>The fastest print speed, but the lowest quality.</td>
</tr>
</tbody>
</table>
6. Press **Start Black** to make a black-and-white copy, or press **Start Color** to make a color copy.

### Changing the number of copies of a photo

To change the number of copies:

1. Lift the scanner lid, and place the original photo face down in the right front corner of the scanner glass.

![Image of a scanner lid being lifted](image)

**IMPORTANT:** Do not load photos in the Automatic Document Feeder (ADF).

2. Close the scanner lid.
3. Press **Home**.
4. Press **▼** to select **Copy Photo**, then press **OK**.
5. Make sure **Quantity** is selected.
6. Press **◄** or **►** to select a number, or use the numeric keypad to enter the number of copies.
7. Press **Start Black** to make black-and-white copies, or press **Start Color** to make color copies.

### Copy Photo Option Settings

<table>
<thead>
<tr>
<th>Copy Photo Option</th>
<th>Settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Photo Paper Quality</td>
<td>Auto. (default)</td>
<td>The printer detects photo paper in the paper tray and sets Best quality automatically.</td>
</tr>
<tr>
<td>Brightness</td>
<td>Normal, -3 to +3 (Normal is default)</td>
<td>Lightens or darkens the copy. Normal is no change from the original; -3 is the darkest; +3 is the lightest.</td>
</tr>
<tr>
<td>Preview</td>
<td>No (default) / Yes</td>
<td>To see a preview of the photograph on the LCD, select <strong>Yes</strong>.</td>
</tr>
<tr>
<td>Save as Defaults</td>
<td>No / Yes</td>
<td>To save settings as the new default, press <strong>OK</strong>, select <strong>Yes</strong>, then press <strong>OK</strong>.</td>
</tr>
</tbody>
</table>
Enlarging or reducing the size of a copy of a photo

To enlarge or reduce the size of the copy:

1. Lift the scanner lid, and place the original photo face down in the right front corner of the scanner glass.

   IMPORTANT: Do not load photos in the Automatic Document Feeder (ADF).

2. Close the scanner lid.
3. Press **Home**.
4. Press **down** to select **Copy Photo**, then press **OK**.
5. Press **down** to select **Copy Size**.
6. Press **left** or **right** to select the copy size.
7. Press **Start Black** to make a black-and-white copy, or press **Start Color** to make a color copy.

---

www.kodak.com/go/aiosupport
Darkening or lightening a copy of a photo

To darken or lighten the copy of the photo:

1. Lift the scanner lid, and place the original photo face down in the right front corner of the scanner glass.

   ![Scanner Image]

   IMPORTANT: Do not load photos in the Automatic Document Feeder (ADF).

2. Close the scanner lid.
4. Press ▼ to select Copy Photo, then press OK.
5. Press ▼ to select Brightness.
6. Press ▼ to select a number below zero for a darker copy, or press ▶ to select a number above zero for a lighter copy.
7. Press Start Black to make a black-and-white copy, or press Start Color to make a color copy.
**Scanning**

Scanning digitizes documents and pictures, and sends the digital files to your computer, memory card, email, network folder, or USB flash drive.

To scan to a computer, the Home Center Software must be installed on that computer, unless you are using the Online Printer Management Tool. (See Scanning from the Online Printer Management Tool, page 82.)

When you scan, the digital file can:

- open in Home Center Software (when Home Center Software is loaded and the printer is connected to a computer with WINDOWS OS).
- open in a third-party scanner software.
- be saved in a format and location that you determine (see Changing the scan settings for scanning from the printer control panel, page 72).

Scanning from a software program on the computer (such as Home Center Software) gives you more options, but you can also scan from the printer control panel.

**Before you begin scanning**

If you are scanning to a computer, make sure that the printer is connected to the computer using a USB cable, Ethernet cable, or wireless network (see Networking Your Printer, page 7).

If you want to scan to an email address or to a shared network folder, you need to:

- make sure the printer is connected to the computer using a wireless or Ethernet connection.
- set up a profile using the Online Printer Management Tool (see Setting up Scan To Email, page 23 and Setting up Scan To Network Folder, page 29).

**Changing the scan settings for scanning from the printer control panel**

Before you scan from the printer control panel, you must adjust the scan settings.

NOTE: These settings do not apply to Scan to Email or Scan to Network Folder. To change scan setting for scanning to email or to network folder, see Setting options for scan to email, page 27 or Setting scan settings for scan to network folder, page 32.

1. Open Home Center Software.
2. Select **Printer Tools** on a computer with WINDOWS OS, or **Tools** on a computer with MAC OS.
   
   NOTE: To get to Printer Tools without Home Center Software (WINDOWS OS only), select **Start > All Programs > Kodak > KODAK AiO Printer Tools**.

3. Under the Tools heading, select **Printer Scan Settings**.
4. Adjust settings for scanning documents and pictures:
   a. To select a program that your scanned images or documents will appear in when you scan from the printer control panel:
      (1) Select the **General** tab.
      (2) Under the Program List heading, click ▼ next to the currently selected program.
      (3) From the list, select the program in which you want the scanned files to open.
   b. To adjust settings for scanning documents, select the **Document** tab, then select an option for each setting:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>File format</td>
<td>.pdf</td>
</tr>
<tr>
<td></td>
<td>.rtf (available only when connected to a computer with WINDOWS OS)</td>
</tr>
<tr>
<td></td>
<td>.tif</td>
</tr>
<tr>
<td></td>
<td>.jpg</td>
</tr>
<tr>
<td></td>
<td>.bmp (available only when connected to a computer with MAC OS)</td>
</tr>
<tr>
<td>Resolution (dpi)</td>
<td>75</td>
</tr>
<tr>
<td></td>
<td>150</td>
</tr>
<tr>
<td></td>
<td>200</td>
</tr>
<tr>
<td></td>
<td>300</td>
</tr>
<tr>
<td>File Save</td>
<td>Prompt for File Name and Location</td>
</tr>
<tr>
<td></td>
<td>Automatically Save - specify:</td>
</tr>
<tr>
<td></td>
<td>• Base name; by default, scanned files are named “scan1”, “scan2”, and so on.</td>
</tr>
<tr>
<td></td>
<td>• Location (folder) where the scanned files will be saved</td>
</tr>
</tbody>
</table>
   c. To adjust settings for scanning pictures, select the **Picture** tab, then select an option for each setting:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>File format</td>
<td>.jpg</td>
</tr>
<tr>
<td></td>
<td>.bmp</td>
</tr>
<tr>
<td></td>
<td>.tif</td>
</tr>
<tr>
<td>Resolution (dpi)</td>
<td>75</td>
</tr>
<tr>
<td></td>
<td>150</td>
</tr>
<tr>
<td></td>
<td>200</td>
</tr>
<tr>
<td></td>
<td>300</td>
</tr>
<tr>
<td></td>
<td>600</td>
</tr>
</tbody>
</table>
### Setting | Options
--- | ---
**Quality** | When connected to a computer with WINDOWS OS:
- Best for E-mail
- Normal
- High
- Maximum
When connected to a computer with MAC OS, a slider bar with:
- Least
- Medium
- Best

**Automatically Detect Pictures (when connected to a computer with WINDOWS OS) or Auto Crop (when connected to a computer with MAC OS)** | When selected, multiple pictures placed on the scanner glass are saved as separate files.

**File Save** | Prompt for File Name and Location
Automatically Save - specify:
- Base name; by default, scanned files are named “scan1”, “scan2”, and so on.
- Location (folder) where the scanned files will be saved

**NOTE:** Before you save a scanned file in Home Center Software, you can preview, crop and sharpen the image, and adjust the color. On a computer with WINDOWS OS, see the Home Center Software Help (icon) for instructions.

5. When you are finished making selections, click **OK** on the bottom right of the Printer Scan Settings window.

6. Close the Printer Tools window.
Loading originals for scanning

You can scan multiple-page, one- or two-sided documents automatically by loading the originals (up to 35 pages) face up in the Automatic Document Feeder (ADF).

IMPORTANT: The ADF accepts plain paper originals from 6.9 to 8.5 in. (18 to 22 cm) wide and 9.8 to 14 in. (25 to 36 cm) long.

To scan a photo, documents on thick or thin paper, or a document that is too small or too large to fit in the ADF, place the original face down on the scanner glass.

For more information on loading originals, see Loading originals, page 45.

Scanning from the printer control panel

When you scan a document or picture(s) from the control panel, you have the following options:

• **Scan to Computer** - scans to a file or to Home Center Software on your computer

• **Scan to Memory Card** - scans to a memory card in the memory card slot

• **Scan to USB Flash Drive** - scans to a flash drive attached to the front USB port

• **Scan to Email** - scans to an email address that you select from the Email Profile you set up in the Online Printer Management Tool

• **Scan to Network Folder** - scans to a shared network folder that you designated in the Online Printer Management Tool

* Before you can use these options, you must set up Scan to Email (see Setting up Scan To Email, page 23) and Scan to Network Folder (see Setting up Scan To Network Folder, page 29) from the Online Printer Management Tool.
Scanning to a computer

To scan to a computer:

1. Load the original(s) (see Loading originals for scanning, page 75).
2. Press Scan on the printer control panel.
3. Select Scan to Computer, then press OK.
4. Press ▼ to select an option, then press ▲ or ▼ to change the setting.

<table>
<thead>
<tr>
<th>Scan Option</th>
<th>Settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scan To</td>
<td>USB-connected Computer (default)</td>
<td>The scanned file is sent to the USB-connected computer.</td>
</tr>
<tr>
<td></td>
<td>Name of computer (only if a computer is connected by wireless or Ethernet network)</td>
<td>The scanned file is sent to the computer on the wireless or Ethernet network.</td>
</tr>
<tr>
<td>Original</td>
<td>1-sided (default)</td>
<td>Original document is printed on one side</td>
</tr>
<tr>
<td></td>
<td>2-sided</td>
<td>Original document is printed on both sides of the page. Select this only if you are scanning both sides of the page and have loaded the document into the ADF.</td>
</tr>
<tr>
<td>Scan What</td>
<td>Document (default)</td>
<td>Sets the scan settings for scanning a document (see Changing the scan settings for scanning from the printer control panel, page 72).</td>
</tr>
<tr>
<td></td>
<td>Photo</td>
<td>Sets the scan settings for scanning a picture (see Changing the scan settings for scanning from the printer control panel, page 72).</td>
</tr>
<tr>
<td>Destination</td>
<td>File (default)</td>
<td>Sends the scanned file in the format and to the location on your computer that you designate.</td>
</tr>
<tr>
<td></td>
<td>Application (available only when Home Center Software is installed on computer)</td>
<td>Sends the scanned file to Home Center Software.</td>
</tr>
<tr>
<td>Save as Defaults</td>
<td>No / Yes</td>
<td>To save the settings as the new default, press OK. With Yes selected, press OK.</td>
</tr>
</tbody>
</table>

5. Press Start Black to make a black-and-white scan, or press Start Color to make a color scan. The scanned file appears at the destination you specified.
## Scanning to a memory card or USB flash drive

To scan to a memory card or USB flash drive:

1. Load the original(s) (see Loading originals for scanning, page 75).
2. Press **Scan** on the printer control panel.
3. Press \( \downarrow \) to select **Scan to Memory Card** or **Scan to USB Flash Drive**, then press **OK**.
4. Press \( \downarrow \) to select an option, then press \( \downarrow \) or \( \uparrow \) to change the setting.

<table>
<thead>
<tr>
<th>Scan Option</th>
<th>Settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scan What</td>
<td>Photo (default)</td>
<td>Sets the scan settings for scanning a picture (see Changing the scan settings for scanning from the printer control panel, page 72).</td>
</tr>
<tr>
<td></td>
<td>Document</td>
<td>Sets the scan settings for scanning a document (see Changing the scan settings for scanning from the printer control panel, page 72).</td>
</tr>
<tr>
<td>File Type</td>
<td>JPG (default)</td>
<td>The scanned file is saved as a JPG.</td>
</tr>
<tr>
<td></td>
<td>Single-page PDF</td>
<td>The scanned file is saved as a single-page PDF.</td>
</tr>
<tr>
<td></td>
<td>Multi-page PDF</td>
<td>The scanned file is saved as a multiple-page PDF.</td>
</tr>
<tr>
<td>Original</td>
<td>1-sided (default)</td>
<td>Original document is printed on one side.</td>
</tr>
<tr>
<td></td>
<td>2-sided</td>
<td>Original document is printed on both sides of the page. Select this only if you are scanning both sides of the page and have loaded the document into the ADF.</td>
</tr>
<tr>
<td>Scan Size</td>
<td>Auto (default)</td>
<td>Determines the size that is scanned.</td>
</tr>
<tr>
<td></td>
<td>2 x 3</td>
<td></td>
</tr>
<tr>
<td></td>
<td>3.5 x 5</td>
<td></td>
</tr>
<tr>
<td></td>
<td>4 x 6</td>
<td></td>
</tr>
<tr>
<td></td>
<td>4 x 7</td>
<td></td>
</tr>
<tr>
<td></td>
<td>4 x 8</td>
<td></td>
</tr>
<tr>
<td></td>
<td>5 x 7</td>
<td></td>
</tr>
<tr>
<td></td>
<td>4 x 12</td>
<td></td>
</tr>
<tr>
<td></td>
<td>8 x 10</td>
<td></td>
</tr>
<tr>
<td></td>
<td>8.5 x 11</td>
<td></td>
</tr>
<tr>
<td></td>
<td>A4</td>
<td></td>
</tr>
<tr>
<td></td>
<td>8.5 x 14</td>
<td></td>
</tr>
<tr>
<td>Save as</td>
<td>No / Yes</td>
<td>To save the settings as the new default, press <strong>OK</strong>. With <strong>Yes</strong> selected, press <strong>OK</strong>.</td>
</tr>
<tr>
<td>Defaults</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

5. Press **Start Black** to make a black-and-white scan, or press **Start Color** to make a color scan. The scanned file appears at the destination you specified.
**Scanning to email**

You can scan your original and immediately send the scanned file by email to one or more recipients directly from the printer.

**NOTE:** You must first use the Online Printer Management Tool to set up scanning to email options (see Setting up Scan To Email, page 23).

1. Load the original.
2. Press **Scan** on the printer control panel.
3. Press  to select **Scan To Email**, then press **OK**.
4. Select an outgoing email profile (the person from whom the email with the scan attachment is sent), then press **OK**.
5. If necessary, enter the 4-digit PIN number (the same 4-digit PIN you set up during Creating the outgoing email profile, page 23), select **Done**, then press **OK**.
6. Select an email recipient, then press **OK**.
7. Repeat step 6 for each recipient.
8. Press **Start Black** to make a black-and-white scan, or press **Start Color** to make a color scan.
9. If desired, load another original, then press **OK** to scan it.
10. Press **Start Black** or **Start Color** to send the scan by email.

**NOTE:** Pressing either Start button triggers the printer to send the scan. It does not matter which Start button you press; whether a scan is color or black and white is determined by what you chose in step 8.
Scanning to network folder

You can scan your original and immediately send the scanned file to a network folder directly from the printer.

NOTE: You must first use the Online Printer Management Tool to set up scanning to network folder options (see Setting up Scan To Network Folder, page 29).

1. Load the original.
2. Press Scan on the printer control panel.
3. Press ▼ to select Scan to Network Folder, then press OK.
4. Select Sharing folder, then press OK.
5. If necessary, enter the 4-digit PIN number (the same 4-digit PIN you set up during Adding a network folder profile, page 30), select Done, then press OK.
6. Press Start Black to make a black-and-white scan, or press Start Color to make a color scan.
7. If desired, load another original, then press OK to scan it.
8. Press Start Black or Start Color to send the scan to a network folder.

NOTE: Pressing either Start button triggers the printer to send the scan. It does not matter which Start button you press; whether a scan is color or black and white is determined by what you chose in step 6.
**Scanning from the computer**

To scan a document or a picture:

1. Load the original.
2. Open Home Center Software, then:
   - on a computer with WINDOWS OS, select **Scan Documents and Pictures**, then follow the on-screen instructions.
   - on a computer with MAC OS, select the **Tools** tab, click **Scan Application**, then follow the on-screen instructions.

**NOTE:** If you are not using Home Center Software, open a program that allows you to scan, then follow the instructions.

**Scanning multiple pictures simultaneously**

Using Home Center Software, you can scan multiple pictures simultaneously and save them as separate files.

When scanning multiple pictures, leave space between the pictures so that the printer can detect the separate pictures. Any pictures that overlap are interpreted as a single picture.

**Scanning multiple pictures when connected to a computer with WINDOWS OS**

To scan multiple pictures simultaneously, and save them as separate files:

1. Lift the scanner lid, and place the pictures face down on the glass, leaving space between the pictures.
2. Close the scanner lid.
3. Open Home Center Software, then select **Printer Tools**.
4. Under the Tools heading, select **Printer Scan Settings**.
5. Select the **Picture** tab.
6. Select **Automatically Detect Pictures**, if it is not selected, then click **OK**.
7. Click the X in the top right corner to close the Printer Tools window.
8. In the Home Center Software, select **Scan Documents and Pictures**.
9. Make sure that **Picture** is selected and **Collage - Combine all pictures** is cleared, then follow the on-screen instructions.

**NOTE:** Click Help (?? icon) for additional instructions.
Scanning multiple pictures when connected to a computer with MAC OS

To scan multiple pictures simultaneously, and save them as separate files:

1. Lift the scanner lid, and place the pictures face down on the glass, leaving space between the pictures.
2. Close the scanner lid.
3. Open Home Center Software, then select your printer.
4. Select the Tools tab.
5. Click Scan Application.
6. Select Color Picture or Black and White Picture.
7. Select Automatically detect multiple pictures, if it is not selected.
8. Click Preview or Scan All, then follow the on-screen instructions.

NOTE: Click Help (?) icon for additional instructions.
Scanning from the Online Printer Management Tool

You can use an Internet browser to initiate a scan from the Online Printer Management Tool on a computer that is connected to the same network as the printer.

1. Open the Online Printer Management Tool in a browser (see Accessing the Online Printer Management Tool, page 18).
2. Select the Applications tab.
3. Select Applications > Webscan in the left pane.
4. Load the original (see Loading originals for scanning, page 75).
5. Select the type of scan you want.
   a. Select Picture or Document.
   b. Select Color or Black & White.
6. Click Preview to see what will be scanned.
   • If needed, click Clear to reposition the original.
7. When you are satisfied with the preview, click Scan. The scanned file will display in a new browser window.
8. In the new browser window, select File > Save As to save the file as a JPEG image on your computer.
Faxing

Your printer can send and receive faxes in either black-and-white or color.

Before you begin faxing

Before you can send or receive faxes, you must connect your printer and set up the fax options.

Connecting the printer for faxing

Selecting the country/region

For the fax to work properly, the country or region selected on the printer must match your location. This setting determines how your faxes are sent and received.

To set the correct country or region:

1. Press Home.
2. Press ☃� to select Printer Settings, then press OK.
3. Press ☃� to select Country/Region, then press OK.
4. Press ☃� to select your country or region, then press OK.

Determining your telephone system type

The instructions for setting up your printer for faxing differ depending on the type of telephone service you have. Determine the type of telephone service you have, and connect your printer accordingly.

IMPORTANT: Use the phone cord that was provided with the printer. If you use any other phone cord, you may not be able to send or receive faxes successfully.

- **Standard telephone service** — telephone service that uses dedicated telephone wiring to transmit only phone signals
- **Cable telephone service** — telephone service that is delivered by a cable television service
- **Digital Subscriber Line (DSL)** — telephone service that uses the wires of a local telephone network to transmit digital data over cables
- **Internet telephone service** (Voice-Over-Internet-Protocol or VOIP) — telephone service delivered by an Internet provider
**Connecting to a Standard or Cable telephone service**

If you have Standard or Cable telephone service, connect one end of the phone cord that came with the printer into the LINE IN port on the back of the printer and the other end into the wall phone jack.

**Connecting to a Digital Subscriber Line (DSL)**

If you have DSL telephone service, connect one end of the phone cord that came with the printer into the LINE IN port on the back of the printer and the other end into the DSL filter (available from your DSL provider), which is connected to the wall phone jack.

**NOTE:** You must use a DSL filter to transmit fax signals properly to your printer.
Connecting to Internet telephone service (Voice-Over-Internet Protocol or VOIP)

If you have Internet telephone service, you should already have a cable modem/router connected to the cable outlet with a coaxial cable. You will also need an Analog Telephone Adapter (ATA) to connect your printer for faxing.

NOTE: Sometimes the cable modem/router has a built-in ATA. Contact your cable telephone service provider for more information.

1. Connect an RJ-45 (also called CAT 5) cable from the cable modem/router to the WAN port on the Analog Telephone Adapter (ATA).

2. Connect one end of the phone cord that came with the printer (RJ-11 telephone cord) to one of the phone input ports on the ATA and the other end to the LINE IN port on the back of your printer.
Determining whether your phone line is dedicated or shared

To connect your printer for faxing correctly, you need to determine whether your phone line is shared or dedicated.

- A **dedicated phone line** is one that has only this printer and no other devices connected to it. If you have a dedicated line, connect your printer as described for your type of phone service (see Connecting to a Standard or Cable telephone service, page 84, Connecting to a Digital Subscriber Line (DSL), page 84, or Connecting to Internet telephone service (Voice-Over-Internet Protocol or VOIP), page 85).

- A **shared phone line** is one that has several devices connected to it, such as a phone and/or answering machine as well as the printer. If you have a shared line, connect your printer in one of the following ways, based on the devices you have connected to the same phone line.

**If you share the line with an answering machine or telephone:**

1. Connect one end of the phone cord that came with the printer into the LINE IN phone port on the back of the printer.
2. Connect the other end of the phone cord into either a wall phone jack or a DSL filter, depending on the type of telephone service you use.
3. Connect one end of the phone cord for your answering machine into the EXT OUT phone port on the back of the printer.
4. Connect the other end of the phone cord into the answering machine or telephone.

   **NOTE:** If you have an answering machine, set the number of rings to answer on the printer to *a higher number* than the rings to answer for the answering machine (see **Rings to Answer** under Selecting fax settings, page 88).

Configuration for connecting an answering machine with a standard telephone service
**If you have an answering service:**

If you have an answering service that uses a computerized system for recording messages remotely for the same phone line that you use for your all-in-one printer, then you can set up a distinctive ring to receive faxes automatically (see **Distinctive Ring** under Selecting fax settings, page 88).

If you do not set up a distinctive ring, you can still receive faxes manually (see Receiving a fax manually, page 100).

---

**Entering fax sender information**

Fax sender information appears in the header of any fax that you send from your all-in-one printer. Typically this is your name or your business name, your fax number, and your phone number.

**NOTE:** If you do not enter fax sender information, the header on faxes that you send will be blank.

To enter fax sender information:

1. Press **Home**.
2. Press ▼ to select **Fax Settings**, then press **OK**.
3. With **Fax Sender Information** highlighted, press **OK**.
4. Use the numeric keypad on the control panel to enter:
   - your name or business name
   - your fax number
   - your phone number
   
   See Using the numeric keypad on the control panel to enter text and/or numbers, page 94.
5. When you are finished entering information in a field, press ▼ to move to the next field.
6. Press **OK** to save the information.
Selecting fax settings

Before sending or receiving faxes, set the fax settings.

1. Press **Home**.
2. Press ✅ to select **Fax Settings**, then press ✅.
3. Press ✅ or ✅ to select a setting, then press ✅ or ✅ to change the option.

<table>
<thead>
<tr>
<th>Fax Setting</th>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fax Sender Information</td>
<td>--</td>
<td>This information appears on the faxes you send. Press <strong>OK</strong>, then enter the fax sender name (your name), your fax number, and your phone number (see Using the numeric keypad on the control panel to enter text and/or numbers, page 94); press <strong>OK</strong> to save.</td>
</tr>
<tr>
<td>Rings to Answer</td>
<td>1 to 6 (default is 4)</td>
<td>The number of times that your phone will ring before the printer picks up the call. If you use a dedicated phone line for your printer, set the Rings to Answer to any setting. If the printer shares the phone line with an answering machine, set the Rings to Answer to a higher number (5 or 6) than the rings to answer for the answering machine (typically 4 rings). This allows the answering machine to pick up phone calls. The printer will monitor the line after the answering machine picks up, and, if set to Auto Answer, will detect an incoming fax and receive it.</td>
</tr>
<tr>
<td>Fax Print</td>
<td>1-sided</td>
<td>The information you want to fax is on one side of the page.</td>
</tr>
<tr>
<td></td>
<td>2-sided*</td>
<td>The information you want to fax is on both sides of the page.</td>
</tr>
</tbody>
</table>

* You must load 2-sided originals in the ADF (see Using the Automatic Document Feeder (ADF), page 46)
<table>
<thead>
<tr>
<th>Fax Setting</th>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fax Speed</td>
<td>Fast - 33.6K (default)</td>
<td>Use this setting to reduce the fax transmission speed of your printer. If you are having difficulty sending or receiving a fax or if your fax works intermittently, then reducing the fax speed to Medium or Slow may resolve the issue. If you are using Vonage or Magic Jack, we recommend that you set the fax speed to Slow.</td>
</tr>
<tr>
<td></td>
<td>Medium - 14.4K</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Slow - 9.6K</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Redial if No Answer</td>
<td>Yes (default) / No If the fax number you call does not answer, the printer will redial the number automatically one time.</td>
</tr>
<tr>
<td></td>
<td>Busy Redial Attempts</td>
<td>0 to 12 (default is 5) The number of times that the fax will attempt to redial a busy number.</td>
</tr>
<tr>
<td></td>
<td>Disable Call Waiting</td>
<td>No (default) / Yes If you have call-waiting service on your phone line, you can disable it so that an incoming call does not interrupt your fax transmission. Select Yes to disable call waiting, then enter the call waiting disable code (below). Note: You must enable call waiting manually after your fax transmission.</td>
</tr>
<tr>
<td></td>
<td>Call-Waiting Disable Code</td>
<td>*70 (default) The printer automatically dials the call waiting disable code before dialing the number to which you are sending a fax. This code disables call waiting for the duration of the fax, preventing incoming calls from interrupting your fax transmission. The usual code to disable call waiting is the default *70. If the call waiting disable code is different in your area, press OK, then press  to erase the current code. Use the keypad to enter the correct code, then press OK.</td>
</tr>
</tbody>
</table>
### Fax Setting Options

<table>
<thead>
<tr>
<th>Fax Setting</th>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Distinctive Ring</td>
<td>Any ring (default) / Single Ring / Double Ring / Triple Ring</td>
<td>This service, available from most phone companies, adds multiple phone numbers to one phone line. Each phone number then has a distinctive ring pattern (single, double, or triple ring) to let you know which number is ringing. Select the ring pattern assigned to the phone number for the printer so the printer can receive faxes automatically.</td>
</tr>
<tr>
<td>Fax Speaker</td>
<td>On (default) / Off</td>
<td>The fax speaker allows you to hear the dial tone and initial fax tones when sending faxes.</td>
</tr>
<tr>
<td>Print Fax Confirmation Page</td>
<td>After Failure Only (default) / Never / Always</td>
<td>The Fax Confirmation Page contains the time and date, the number you called, the number you called from, and whether the transmission was successful.</td>
</tr>
<tr>
<td>Print Fax Settings</td>
<td>--</td>
<td>To print the current fax settings, press <strong>OK</strong>. Load letter or A4 paper, then press <strong>Start Black</strong> or <strong>Start Color</strong>.</td>
</tr>
<tr>
<td>Print Fax Cover Page</td>
<td>--</td>
<td>The Fax Cover Page shows the date and headings for To and From information for your fax. Use this cover page, if needed, when sending your fax. To print a Fax Cover Page, press <strong>OK</strong>. Load letter or A4 paper, then press <strong>Start Black</strong> or <strong>Start Color</strong>. (The Fax Cover Page is black-and-white.)</td>
</tr>
<tr>
<td>Print Fax Activity Log</td>
<td>--</td>
<td>The Fax Activity Log contains information (date, time, duration, to/from, number of pages, and more) about the last 30 faxes sent and/or received. To print a Fax Activity Log, press <strong>OK</strong>. Load letter or A4 paper, then press <strong>Start Black</strong> or <strong>Start Color</strong>.</td>
</tr>
</tbody>
</table>
To adjust fax settings from the Online Printer Management Tool:

1. Open the Online Printer Management Tool in a browser (see Accessing the Online Printer Management Tool, page 18).
2. Select the Settings tab, then select Fax > Settings.
3. Change the Sender Information and/or fax Settings as needed.
4. Click Save to update the settings.

**Setting the answer mode (auto answer or manual)**

The default setting for Auto-Answer is on. When Auto Answer is on, the printer picks up all incoming faxes automatically. The green Auto Answer LED is lit when Auto Answer is on.

To answer calls manually, turn off Auto Answer by pressing the Auto Answer button so that the green LED is off. (See Receiving a fax manually, page 100.)
**Working with the phonebook**

You can enter up to 60 fax numbers in the phonebook.

You can create and manage the phonebook from the printer LCD or, if your printer is connected to a computer with WINDOWS OS, you can use Home Center Software.

You can also use the Online Printer Management Tool to edit the Fax Phone Book. See *Editing the fax phone book, page 21*.

**Using symbols in phonebook entries**

The following symbols are used in phonebook entries:

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
<th>Response by fax</th>
</tr>
</thead>
<tbody>
<tr>
<td>0 - 9</td>
<td>numbers</td>
<td>Dials the number</td>
</tr>
<tr>
<td>*</td>
<td>star</td>
<td>Used for special features (for example, *70 is used to deactivate call waiting)</td>
</tr>
<tr>
<td>,</td>
<td>comma</td>
<td>Causes a 2-second delay before dialing the remaining numbers</td>
</tr>
<tr>
<td>#</td>
<td>pound</td>
<td>Used for special features (for example, # at the end of a number signifies the completion of the number sequence)</td>
</tr>
</tbody>
</table>
Adding a new phonebook entry

To add a new phonebook entry:

1. Press **Phonebook**.
2. Make sure **Edit Phonebook** is selected, then press **OK**.
3. Make sure **Add New Entry** is selected, then press **OK**.
4. Make sure **Number** is selected, then press **OK**.
5. Use the numeric keypad on the control panel to enter a fax number, then press **OK**.
6. With **Name** selected, press **OK**.
7. Use the LCD keyboard to enter a name:
   
   a. On the control panel, press ↑, ↓, ← or → to select the letters.
   b. When you are finished, select **DONE**, then press **OK**.
8. Optional: Assign a Quick Dial number.
   Set up your ten most frequently used fax numbers as Quick Dial numbers. You will be able to dial them quickly, and they will be displayed at the top of your phonebook.
   a. Press ↓ to select **Quick Dial**, then press **OK**.
   b. Using the numeric keypad on the control panel, enter a number from 0 to 9, then press **OK**.
9. Press ↓ to select **DONE**, then press **OK**.

Editing a phonebook entry

To edit a phonebook entry:

1. Press **Phonebook**.
2. Make sure **Edit Phonebook** is selected, then press **OK**.
3. Press ↓ to select **Edit Entry**, then press **OK**.
4. Press ↓ to select the entry you want to edit, then press **OK**.
5. Press ↓ to select the field you want to edit, then press **OK**.
6. Use the LCD keyboard and/or numeric keypad to make your change(s).
7. Press ↓ to select **DONE**, then press **OK**.
Deleting a phonebook entry

To delete a phonebook entry:

1. Press **Phonebook**.
2. Make sure **Edit Phonebook** is selected, then press **OK**.
3. Press **↓** to select **Delete Entry**, then press **OK**.
4. Press **↓** to select the entry you want to delete, then press **OK**.
   NOTE: If you do not want to delete the entry, press **Cancel**.
5. To delete the entry, press **OK**.
   The entry is deleted from the phonebook.
6. Repeat steps 4 – 5 to delete more entries; when you are finished, press **Back** or **Cancel**.

Using the numeric keypad on the control panel to enter text and/or numbers

The number keys on the numeric keypad represent a number and several characters. For example, the number 2 key also represents the letters A, B, C and a, b, and c. You must press the 2 key multiple times to enter a corresponding letter. For example, to enter the letter “B” as the first letter of a name, press the 2 key two times; to enter the lowercase “b” at the beginning of a name, press the 2 key five times. If the lowercase “b” is not at the beginning of a name or word, press the 2 key two times.

If you need to use the same key for more than one letter in a row (for example, to type “Cab”), you need to pause between letters. To type “Cab”, press the 2 key three times to enter “C”, then pause 3 to 4 seconds; press the 2 key once to enter “a”, then pause 3 to 4 seconds; and press the 2 key two times to enter “b”. You do not need to pause if the next letter is on a different key.

Note that the Symbols (*) key and the Space (#) key also cycle through several different symbols when you press the key multiple times.

To make a correction to your entry, select **BKSP** on the LCD, then press **OK**. This erases the rightmost character.

Using the Online Printer Management Tool to edit the Fax Phone Book

You may use the Online Printer Management Tool to edit your fax phonebook. See Editing the fax phone book, page 21.
Preparing a fax for transmission

Before you send a fax, prepare a cover page (if needed), load the original(s), and change the resolution and brightness (if needed).

Printing a fax cover page

If you need a fax cover page, you can print one with your printer, then manually complete the information (person to whom you are sending, fax number, your name, etc).

To print a fax cover page:

1. Press Home.
2. Press ▼ to select Fax Settings, then press OK.
3. Press ▼ to select Print Fax Cover page, then press OK.
4. Load letter or A4 paper, then press Start Black or Start Color to begin printing.
   NOTE: It does not matter which Start button you press; the fax cover prints in black-and-white only.

Loading originals for faxing

To fax documents (up to 35 pages) that are on plain paper, load the original(s) face up in the Automatic Document Feeder (ADF).

IMPORTANT: The ADF accepts plain paper originals from 6.9 to 8.5 in. (18 to 22 cm) wide and 9.8 to 14 in. (25 to 36 cm) long.

To fax a photo, documents on thick or thin paper, or a document that is too small or too large to fit in the ADF, place the original face down on the scanner glass. You can fax only one page at a time from the scanner glass.

For more information on loading originals, see Loading originals, page 45.

Setting fax option for one-sided or two-sided original

Before sending your fax, select whether the original is one-sided or two-sided:

1. Press Fax.
2. With Fax Options selected, press OK.
3. Press ▼ to select Original.
4. Press ▼ to select 1-sided or 2-sided.

NOTE: If you do not want to save these settings, send your fax. The settings will apply only to the current transmission. If you want to save these settings as defaults:
   a. Press ▼ to select Save as Defaults, then press OK.
   b. Select Yes, then press OK.
Changing resolution and brightness

Before sending your fax, change the resolution and brightness settings, as needed, based on your original.

To modify settings before sending your fax:

1. Press Fax.
2. With Fax Options selected, press OK.
3. Press ▼ to select Resolution.
   The resolution setting determines the amount of detail that is transmitted.
   Select:
   • Standard (default) for most documents
   • Fine for documents with fine print
   • Photo for photographs
4. Press ▼ to select Brightness.
   Adjust the brightness setting according to how light or dark your original is.
   Select:
   • Normal (default) for most documents
   • +1 to +3 to lighten dark originals
   • -1 to -3 to darken light originals

NOTE: If you do not want to save these settings for future faxes, send your fax. The settings will apply only to the current transmission. If you want to save these settings as defaults:

a. Press ▼ to select Save as Defaults, then press OK.
b. Select Yes, then press OK.
Sending a fax

You can send your fax in several ways. You can use:

- the phonebook
- Quick Dial
- the numeric keypad
- the Redial button
- your computer

NOTE: If the receiver's fax machine is not set up to print color, the fax will print in black-and-white.

Using the phonebook to send a fax

To send a fax to a number in the phonebook:

1. Press Phonebook.
2. Press \( \text{\箭头} \) to select the desired number.
3. Press Start Black to send a black-and-white fax or Start Color to send a color fax.

Using Quick Dial to send a fax

To send a fax using Quick Dial:

1. Press Phonebook.
2. Press the number on the keypad that corresponds to the desired Quick Dial entry.
3. Press Start Black to send a black-and-white fax or Start Color to send a color fax.

Using the numeric keypad to send a fax

To send a fax using the numeric keypad:

1. Press Fax.
2. Enter a fax number using the numeric keypad.
3. Press Start Black to send a black-and-white fax or Start Color to send a color fax.
Using the Redial button to send a fax

To send a fax to one of the last numbers dialed:

1. Press **Redial**.
2. Press ▼ to select an entry.
3. Press **Start Black** to send a black-and-white fax or **Start Color** to send a color fax.

If there is no number to redial, the phonebook opens.

Sending a fax from your computer

To send a fax from your computer, you must have Home Center Software installed on your computer.

Sending a fax from a computer running WINDOWS OS:

To send a fax from a computer running WINDOWS OS:

1. Open the document you want to fax, then select **File > Print**.
2. In the print dialog box, make sure that **KODAK HERO 6.1 AiO Fax Driver** is selected, then click **Properties** or **Preferences**.
3. Select a paper size (letter or A4) from the drop-down menu, then select a resolution, and orientation as needed.
4. Enter the fax number in the **Enter Fax Number** field, then click **OK**.
5. Click **OK** to send the fax.

Sending a fax from a computer running MAC OS:

To send a fax from a computer running MAC OS:

1. Open the document you want to fax, then select **File > Print**.
2. Expand the print dialog box, if necessary.
3. Select **Fax Options** from the drop-down menu.
4. Select a paper size (US Letter or A4 only) from the drop-down menu, then select an orientation as needed.
5. Check the Send as Fax check box, then enter the fax number in the **To** field.
6. Select a fax quality (Standard or Best).
7. Click **Print** to send the fax.
Receiving a fax

You can set up your printer to receive faxes automatically or manually. Even if your printer is set up to receive faxes automatically, you can still receive them manually at any time.

Receiving a fax automatically

To receive faxes automatically:

1. Load letter (8.5 x 11 in. / 22 x 28 cm) or A4 (8.3 x 11.7 in. / 21 x 30 cm) plain paper into the paper tray (see Loading plain paper, page 40).
2. Make sure the Auto Answer LED is on. (If not, press Auto Answer on the control panel to turn it on.)

The printer will receive all incoming faxes automatically.

IMPORTANT: Whenever there is an incoming fax, the printer LCD shows the message, “Incoming Call. Press START to Answer.” If the Auto Answer LED is on, you do not need to press START to receive the fax. The printer will automatically receive the fax after the number of rings that you selected for the fax settings (see Rings to Answer under Selecting fax settings, page 88). However, you may choose to receive the fax sooner by pressing either START button. (Whether the fax is color or black-and-white is determined by the sender.)
Faxing

Receiving a fax manually

If Auto Answer is turned off for your printer, you can receive incoming faxes manually. You can receive any incoming fax manually, even if Auto Answer is turned on.

To receive a fax manually:

- When you hear the phone ring, press **Start Black** or **Start Color**.
  
  NOTE: Pressing either Start button prompts the printer to receive the fax. It does not matter which Start button you press; whether a fax is color or black-and-white is determined by the sender.

If your printer is connected to the same phone line as another telephone and you are using tone dialing (see **Dialing Mode** under **Selecting fax settings, page 88**), you may receive an incoming fax manually from another phone. When you hear the distinctive ring of your fax line or know that the incoming call is a fax:

- Pick up any phone and dial **234** (the remote access code).

Printing fax reports

You can set up the printer to print certain reports automatically. You can also print reports manually at any time.

Fax settings report

To print the current fax settings:

1. Press **Home**.
2. Press ▼ to select **Fax Settings**, then press **OK**.
3. Press ▼ to select **Print Fax Settings**, then press **OK**.
4. Load letter (8.5 x 11 in. / 22 x 28 cm) or A4 (8.3 x 11.7 in. / 21 x 30 cm) plain paper, then press **Start Black** or **Start Color**.
Fax confirmation page

The Fax Confirmation Page contains the time and date of transmission, the number that you called and the number you called from, and whether the transmission was successful. To print the Fax Confirmation Page, you must select the option to print it before you transmit the fax. The default setting is to never print the Fax Confirmation Page.

To print the Fax Confirmation Page for future faxes:

1. Press Home.
2. Press ▼ to select Fax Settings, then press OK.
4. Press ▼ or ▼ to select Always (to print a confirmation page after sending every fax) or After Fail Only to print only if the fax transmission fails.
5. Press OK.

NOTE: The name and fax number of receivers will not appear on your confirmation page if the receivers have not set up that information on their fax machines.

Fax activity log

The Fax Activity Log provides detailed information for approximately the last 30 faxes sent or received. The log contains information such as date, time, duration of transmission, to/from, and number of pages.

To print a Fax Activity Log:

1. Press Home.
2. Press ▼ to select Fax Settings, then press OK.
3. Press ▼ to select Print Fax Activity Log, then press OK.
4. Load letter (8.5 x 11 in. / 22 x 28 cm) or A4 (8.3 x 11.7 in. / 21 x 30 cm) plain paper, then press Start Black or Start Color.

NOTE: The name and fax number of receivers will not appear on your Fax Activity Log if the receivers have not set up that information on their fax machines.

Canceling a fax

You can cancel a fax that you are sending or receiving at any time.

To cancel sending or receiving a fax, press Cancel.
Maintaining Your Printer

Your printer requires little maintenance. However, Kodak recommends cleaning the scanner glass and lid regularly to remove dust and fingerprints, which affect the quality and accuracy of scanning and copying.

Except while cleaning the printer, keep the printer plugged into an AC power outlet. If you use a power strip, don’t turn off the power strip. (The printer does not need to be turned on but should be plugged in.)

Keep the printhead and ink cartridges in the printer at all times to help prevent damage to the printhead.

For recycling and/or disposal information, contact your local authorities. In the US, go to the Electronics Industry Alliance at www.eia.org or go to www.kodak.com/go/recycle.

General care and cleaning

⚠️ CAUTION:
Always disconnect the power to the printer before cleaning it. Do not use harsh or abrasive cleaners on any part of the printer.

- To clean the printer, wipe the outside with a clean, dry cloth.
- Keep the surrounding area vacuumed and litter-free.
- Protect the printer from tobacco smoke, dust, and liquid spills.
- Do not place objects on the printer.
- Keep the paper tray free of dust, dirt, and other foreign objects.
- Keep the printer supplies away from direct sunlight and out of high-temperature environments.
- Do not allow chemicals to come into contact with the printer.
Cleaning the scanner glass and document backing

The scanner glass can get smudged and minor debris can accumulate on the white document backing under the scanner lid. Periodically clean the scanner glass and document backing.

⚠️ CAUTION: Do not use harsh or abrasive cleaners on any part of the printer. Do not spray liquid directly on the glass. Do not use paper-based wipes on the document backing as they can scratch it.

To clean the scanner glass and document backing under the scanner lid:

1. Turn off the printer and unplug it from the power outlet.
2. Lift the scanner lid.
3. Wipe the glass with a soft cloth or sponge, slightly moistened with a nonabrasive glass cleaner.
4. Dry the glass with a lint-free cloth.
5. Gently clean the document backing with a soft cloth or sponge, slightly moistened with mild soap and warm water.

6. Dry the document backing with a chamois or soft, lint-free cloth.
   NOTE: If the document backing needs further cleaning, use isopropyl (rubbing) alcohol on a soft cloth, then wipe thoroughly with a cloth moistened with water to remove any residual alcohol.

7. When you finish cleaning, plug in the printer.
Replacing ink cartridges

Your printer uses black and color ink cartridges. You can check the approximate ink levels on the LCD (see Checking ink levels, page 114) or in Home Center Software. When an ink cartridge is out of ink, the printer LCD displays a message stating that the black or color ink cartridge needs replacing.

IMPORTANT: Do not use non-Kodak brand or refilled ink cartridges.

To replace an ink cartridge:
1. Make sure the printer is on.
2. Lift the access door, and wait for the carriage to move to the access position.

The ink cartridges are located in the printhead.
3. Pinch the tab on the ink cartridge.

4. Lift the ink cartridge out of the printhead.

5. Remove the new ink cartridge from its bag.

IMPORTANT: To prevent the printhead from drying out, insert the ink cartridge into the printhead immediately.
6. Remove the cap.

7. Insert the ink cartridge into the printhead.

8. Press down on the ink cartridge tab until you hear a click.

9. Close the access door.
Replacing the printhead

IMPORTANT: Replacing the printhead is not a regular maintenance procedure. Replace the printhead only if you receive a new printhead from Kodak.

To replace the printhead:
1. Make sure the printer is on.
2. Lift the access door, and wait for the carriage to move to the access position.
3. Remove both ink cartridges and set them aside.
4. Unlatch the existing printhead by lifting the button.

5. Lift the printhead out of the carriage.

6. Remove the new printhead from its bag.

⚠️ **CAUTION:**
Do not touch the gold contacts on the printhead, as doing so may damage it.
7. Remove the plastic protective caps.

8. Install the new printhead in the carriage.

9. Push firmly against the target label of the printhead until you hear a click.
10. Insert the black ink cartridge into the printhead.

11. Press down on the ink cartridge until you hear a click.

12. Repeat steps 10 - 11 for the color ink cartridge.

13. Close the access door.
The printer detects the new printhead. Follow the instructions on the LCD to calibrate your printer.
Updating the software and printer firmware

Using the latest software and firmware helps ensure optimal performance of your printer.

NOTE: Firmware is the software that runs on the printer.

Although there is an automatic check for software and firmware updates when your computer is connected to the Internet, you can update manually using the following procedure.

Updating if your printer is connected to a computer with WINDOWS OS

To update the software:
1. Make sure that your computer is connected to the Internet.
2. Open Home Center Software, then select Printer Tools.
   NOTE: If you do not have Home Center Software, select Start > All Programs > Kodak > KODAK AiO Printer Tools.
3. Under Printer Resources, click Check for Software Updates to check whether software updates are available.
4. If there are updates, click Next and follow the on-screen instructions.

To update the printer firmware:
1. Make sure that your computer is connected to the Internet.
2. Connect the printer to the computer with a USB cable, Ethernet cable, or wirelessly (if not currently connected).
3. Open Home Center Software, then select Printer Tools.
   NOTE: If you do not have Home Center Software, select Start > All Programs > Kodak > KODAK AiO Printer Tools.
4. Make sure that KODAK OFFICE HERO 6.1 AiO - Connected (or a similar name with “Connected”) appears in the lower left corner of the Printer Tools window.
   NOTE: If KODAK OFFICE HERO 6.1 AiO - Connected does not appear in the lower left corner, click Select, then click Refresh List and choose your printer from the list; click OK and follow the on-screen instructions.
5. Under Printer Resources, click Check for Printer (Firmware) Updates.
6. If there are updates, click Next and follow the on-screen instructions.

IMPORTANT: Do not turn off or unplug your printer or your computer during the update. Doing so may cause the printer to become inoperable. If the printer is connected wirelessly, make sure you have a stable connection when you perform the update. During the upgrade, your printer will restart. Wait for the message, “Update complete! You may now use your Kodak Printer” to appear on your computer.
Updating if your printer is connected to a computer with MAC OS

To update the software:
1. Make sure that your computer is connected to the Internet.
2. Open Home Center Software.
3. Select the Tools tab.
4. Click Check for Software Updates.
5. If there are software updates, follow the on-screen instructions.

To update the firmware:
1. Make sure that your computer is connected to the Internet.
2. Connect the printer to the computer with a USB cable, Ethernet cable, or wirelessly (if not currently connected).
3. Open Home Center Software.
4. Select the Tools tab.
5. Click Check for Printer (Firmware) Updates.
6. If there are updates, follow the on-screen instructions.

IMPORTANT: Do not turn off or unplug your printer or your computer during the update. Doing so may cause the printer to become inoperable. Your printer will restart during the update.
Monitoring and adjusting printer performance

From the control panel, you can perform tasks to help keep the printer functioning well.

Checking ink levels

To check the ink levels:
1. Press Home.
2. Press ▼ to select Maintenance, then press OK.
3. With Check Ink Levels selected, press OK.

The LCD shows approximate levels of ink in the cartridges so you know when it’s time to order replacement cartridges. Use 10 Series ink cartridges.

NOTE: You can order ink cartridges online. Open Home Center Software and select Order Supplies or go to www.kodak.com/go/printingsupplies.

Checking paper levels

To check the paper level:
1. Press Home.
2. Press ▼ to select Maintenance, then press OK.
3. Press ▼ to select Paper Levels, then press OK.

The LCD shows approximate levels of paper so you know when it’s time to order more.

NOTE: You can order paper online. Go to www.kodak.com/go/inkjetpaper.

Resetting factory defaults

To reset defaults to the factory default settings:
1. Press Home.
2. Press ▼ to select Printer Settings, then press OK.
3. Press ▼ to select Reset All Settings, then press OK.
4. When you see the message, “This will reset printer settings to factory defaults,” press OK.

NOTE: Resetting factory defaults does not change the date and time, language, or country/region.
# Troubleshooting

## Basic troubleshooting

If you experience an error with your printer, restarting your printer will sometimes fix the problem. Turn off your printer, wait five seconds, then turn on your printer. If you still experience a problem, use the following information to help troubleshoot your printer.

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Solutions</th>
<th>Wireless connectivity</th>
</tr>
</thead>
</table>
| Printer does not power on | • Make sure you are using the power cord that came with your printer.  
• Make sure that the power cord is connected to the AC adapter and is plugged into an outlet or power strip, and that the LED on the AC adapter is lit.  
• Make sure that the power cord is securely connected to the power cord port in the back of the printer.                                                                 | For wireless connectivity issues, go to [www.kodak.com/go/inkjetnetworking](http://www.kodak.com/go/inkjetnetworking). |
| Printer not detected      | • Make sure that your printer is plugged in and turned on.  
• If you are using a USB cable, make sure that:  
  - it is a USB 2.0 high-speed cable.  
  - it is connected to both your printer and your computer.  
  - you restart the computer if the USB cable was disconnected from the printer then reconnected, or if power to the printer was interrupted.  
• If you are using a wireless connection, make sure:  
  - the Wi-Fi connectivity LED remains lit.  
  - the printer is connected to your wireless network.  
  - your router is transmitting data.  
  - the firewall (excluding WINDOWS Firewall) is allowing the services needed for your printer.  
  To check:  
  a. On the printer, press **Home.**  
  b. Press ◀ to select **Network Settings,** then press **OK.**  
  c. Press ◀ to select **View Network Configuration,** then press **OK.**  
  Make sure that the Active Connection Type is Wi-Fi, and that the IP Address is not all zeros.  
  - the firewall (excluding WINDOWS Firewall) is allowing the services needed for your printer.                                                                 | For additional information, go to [www.kodak.com/go/inkjetnetworking](http://www.kodak.com/go/inkjetnetworking). |
| Carriage jam              | • Open the access door and clear any obstructions.  
• Make sure that the printhead and ink cartridges are installed correctly.  
  (The printhead and ink cartridges are installed correctly when you hear them click into place.)                                                                 |                       |
| Ink cartridge errors      | • Make sure that KODAK Ink Cartridges are installed. Do not use non-Kodak brand or refilled ink cartridges.  
• Remove, then install the cartridges again. Make sure the cartridges click into place.                                                                                                                     |                       |
## Troubleshooting

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Solutions</th>
</tr>
</thead>
</table>
| Too much paper curl after printing | • If you are printing pictures or documents with large areas of image content, try increasing the top and bottom margins when printing in portrait mode or the left and right margins when printing in landscape mode. Start with a 1.0-inch (2.5-cm) margin on top and bottom and a 0.25-inch (0.62-cm) margin on the sides. The larger the margin, the less potential there is for curl.  
• Print on a higher weight paper, such as 24 lb (90 gsm) paper, or print on KODAK Ultimate Paper.  
• Apply a border rather than printing in borderless mode.  
• If the paper is not stacking properly in the output tray, remove the pages as they exit. |
| Print quality | • For best results, use KODAK Paper or a paper with the COLORLOK Technology logo on the package.  
• Make sure the paper is loaded correctly. See Loading plain paper, page 40 and Loading photo paper, page 42.  
• Clean the printhead:  
  – Press **Home**.  
  – Press **▼** to select **Maintenance**, then press **OK**.  
  – Press **▼** to select **Clean Printhead**, then press **OK**.  
• Calibrate the printer:  
  – Press **Home**.  
  – Press **▼** to select **Maintenance**, then press **OK**.  
  – Press **▼** to select **Calibrate Printer**, then press **OK**.  
For more information, go to www.kodak.com/go/hero6_1support, then type the problem in the search field. |
| Paper jam | • Check for paper behind the duplexer in the cleanout area.  
• Remove the duplexer and gently remove any paper from inside the printer.  
• Make sure the paper in the tray is free of tears or creases.  
• Make sure you do not overload the paper tray.  
For more information, go to www.kodak.com/go/hero6_1support, then type jam in the search field. |
## Getting help on the Web

For more troubleshooting information:

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Solutions</th>
</tr>
</thead>
</table>
| Cannot send or receive a fax | • Make sure that the wall phone line is plugged into the Line in port.  
• Verify that the wall jack works by plugging in a phone and checking for a dial tone.  
• Verify that Regions is set to the correct country code.  
  – Press Home.  
  – Press ▼ or ▲ to select Printer Settings, then press OK.  
  – Press ▼ to select Country/Region, then press OK.  
  – Press ▼ or ▲ to select your country, then press OK.  
• If you are connected to a DSL phone line, make sure you have a DSL filter connected to the phone jack.  
For more information, go to www.kodak.com/go/hero6_1support, then type Fax in the search field |
| Error codes/messages or other problems you cannot resolve | • Go to www.kodak.com/go/hero6_1support, then type your error code or message.  
If you need to contact Kodak (see www.kodak.com/go/contact), have the following information available:  
• KODAK Service Number (located inside the printer when you open the access door)  
• Printer model number (located on the control panel)  
• Computer model, operating system, and version of Home Center Software  
• Exact wording of any error message(s) and the error code |

### Get help with wireless networking.
www.kodak.com/go/inkjetnetworking

### Search our knowledge base of Answers to Questions.
www.kodak.com/go/hero6_1support

### Download the latest firmware and software for optimal printer performance.
www.kodak.com/go/hero6_1downloads

### Check the Extended User Guide for detailed instructions and the recommended system requirements.
www.kodak.com/go/hero6_1manuals
Get help with problems you cannot resolve. | Contact Kodak at [www.kodak.com/go/contact](http://www.kodak.com/go/contact) and have the following information available:
- KODAK Service Number (located inside the printer when you open the access door)
- Printer model number (located on the control panel)
- Computer model, operating system, and version of Home Center Software
- Exact wording of any error message(s) and the error code
Status lights

The status lights indicate the condition of the printer. There are two status lights on the printer: one that indicates power, the other indicates Wi-Fi status.

Power status light

<table>
<thead>
<tr>
<th>Power light</th>
<th>What it means</th>
</tr>
</thead>
</table>
| Off         | The printer is turned off.  
  • Press the power button to turn on power.
  The printer does not have power.  
  • Make sure that the power cord is plugged into the back of the printer and into an electrical outlet, and that the electrical outlet has power. |
| Blinking    | The printer is busy.  
  • Wait for the printer to finish the task. |
| On          | The printer is ready. |

Wi-Fi status light

<table>
<thead>
<tr>
<th>Wi-Fi status light</th>
<th>What it means</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td>The Wi-Fi radio is either turned off or is turned on but not connected to a wireless network.</td>
</tr>
<tr>
<td>Blinks continuously</td>
<td>The Wi-Fi radio is turned on, and the printer is searching for available wireless networks within range.</td>
</tr>
</tbody>
</table>
| Blinks intermittently | The Wi-Fi radio is turned on and the printer cannot find any available wireless networks within range, or the Wi-Fi radio connection has been interrupted or is too weak to send signals.  
  To find and connect to an available wireless network within range, press **OK**, turn the Wi-Fi radio off, and run the Wi-Fi Setup Wizard (see [Connecting to a wireless network](#), page 7). |
| On                 | The Wi-Fi radio is turned on, and there is a working connection between the printer and a wireless network. |
Product and Safety Specifications

The following specifications are subject to change without notice.

Features and Specifications

Print performance

- **Black print speed**: 8.5 ipm
- **Color print speed**: 5.5 ipm
- **Print technology**: Continuous-tone, thermal inkjet
- **Print quality modes**: Draft, Normal, and Best on plain paper
  - Photo quality mode on photo paper

Photo printing features

- **Quantity**: 1 to 99
- **Print sizes**: 2 x 3 in. / 5 x 8 cm
  - 3.5 x 5 in. / 9 x 13 cm
  - 4 x 6 in. / 10 x 15 cm
  - 4 x 7 in. / 10 x 18 cm
  - 4 x 8 in. / 10 x 20 cm
  - 4 x 12 in. / 10 x 30 cm (Panoramic)
  - 5 x 7 in. / 13 x 18 cm
  - 8 x 10 in. / 20 x 25 cm
  - US Letter (8.5 x 11 in. / 22 x 28 cm)
  - A4 (8.3 x 11.7 in. / 21 x 30 cm)
- **Quality**: Best, Normal, Draft modes on plain paper
  - Photo quality mode on photo paper
- **Auto-detect media**: Auto-detect plain paper and photo papers
  - Optimize image quality for KODAK Photo Papers with barcode
- **Image enhancement**: KODAK PERFECT TOUCH Technology with Home Center Software (from the computer only)
- **Color**: Black-and-white or color
- **Scene balance**: On (default), Off
Copy document features

- **Color**: Black-and-white or color
- **Quantity**: 1 to 99 copies
- **Copy sizes**: Same Size, Fit to Page, 20% to 500%
- **Plain paper quality**: Best, Normal, Draft
- **Brightness**: -3 to +3

Copy photo features

- **Color**: Black-and-white or color
- **Quantity**: 1 to 99
- **Copy sizes**: 2 x 3 in. / 5 x 8 cm
  3.5 x 5 in. / 9 x 13 cm
  4 x 6 in. / 10 x 15 cm
  4 x 7 in. / 10 x 18 cm
  4 x 8 in. / 10 x 20 cm
  4 x 12 in. / 10 x 30 cm (Panoramic)
  5 x 7 in. / 13 x 18 cm
  8 x 10 in. / 20 x 25 cm
  US Letter - 8.5 x 11 in. / 22 x 28 cm
  A4 - 8.3 x 11.7 in. / 21 x 30 cm
- **Quality**: Automatic
- **Brightness**: -3 to +3

Scanning features

- **Scanner type**: Contact Image Sensor (CIS)
- **Scan sizes**: Maximum size of original scanned from scanner glass:
  8.5 x 11.7 in. / 216 x 297 mm
- **Sizes of originals scanned from ADF**:
  B5 (6.9 x 9.8 in. / 18 x 25 cm)
  US Executive (7.3 x 10.5 in. / 18 x 27 cm)
  US Letter (8.5 x 11 in. / 22 x 28 cm)
  A4 (8.3 x 11.7 in. / 21 x 30 cm)
  US Legal (8.5 x 14 in. / 22 x 36 cm)
- **Resolution and bit depth**: Supports native scan resolution of 2400 dpi
- **Functions**: Segmentation scanning
  Auto-destination
  Optical Character Recognition (OCR)
Input paper tray

- **Paper capacity** 200 sheets of 20 lb plain paper
- 70 sheets of photo paper, up to 12 mil (290 gsm)
- 20 envelopes

- **Tray size** 4 x 6 in. to 8.5 x 14 in. / 10 x 15 cm to 22 x 36 cm

Output paper tray

- **Paper capacity** 50 sheets of 20 lb plain paper
- 20 sheets of photo paper, up to 12 mil (290 gsm)

Automatic document feeder (ADF) for originals

- **Paper capacity** 35 sheets of 20 lb plain paper

- **Paper size limitations** 6.9 to 8.5 in. wide / 176 x to 216 mm wide:
  9.8 to 14 in. long / 250 x to 356 mm long

Fax system

- **Fax modem** 33.6 kbps V.34

- **Fax resolution** 200 x 100 (standard), 200 x 200 (fine), 300 x 300 (photo)

- **Fax phonebook** 60 numbers

- **Quick dial** 10 of the 60 phonebook entries

- **Memory dial** 100-page fax memory at 96 dpi

Paper types supported

- **Plain paper** 16 to 24 lb (60 to 90 gsm)

- **Photo paper** 6.5 to 12 mil

- **Card stock** 110 lb / 200 gsm index max

- **Envelopes** 20 to 24 lb (75 to 90 gsm)

- **Transparencies** All commercially available inkjet varieties (with a white stripe on the short edge)

- **Labels** All commercially available inkjet varieties on 8.5 x 11 in. / 22 x 28 cm and A4 (8.3 x 11.7 in. / 21 x 30 cm) size sheets

- **Iron-on transfers** All commercially available inkjet varieties on 8.5 x 11 in. / 22 x 28 cm and A4 (8.3 x 11.7 in. / 21 x 30 cm) size sheets
Paper sizes supported

**Plain paper**
- A4 (8.3 x 11.7 in. / 21 x 30 cm)
- A5 (5.8 x 8.3 in. / 15 x 21 cm)
- A6 (4.1 x 5.8 in. / 11 x 15 cm)
- B5 (6.9 x 9.8 in. / 18 x 25 cm)
- US Executive (7.3 x 10.5 in. / 18 x 27 cm)
- US Letter (8.5 x 11 in. / 22 x 28 cm)
- US Legal (8.5 x 14 in. / 22 x 36 cm)
- Custom sizes from 4–8.5 in. / 10–22 cm wide and 6–14 in. / 15–36 cm long

**Labels**
- A4 (8.3 x 11.7 in. / 21 x 30 cm)
- US Letter (8.5 x 11 in. / 22 x 28 cm)

**Index card stock**
- 4 x 6 in. index cards (10 x 15 cm)
- 5 x 7 in. index cards (13 x 18 cm)

**Iron-on transfers**
- A4 (8.3 x 11.7 in. / 21 x 30 cm)
- US Letter (8.5 x 11 in.) (22 x 28 cm)

**Envelopes**
- C5 (6.4 x 9 in. / 16 x 23 cm)
- C6 (4.5 x 6.4 in. / 11 x 16 cm)
- DL (designated long) (4.3 x 8.7 in. / 11 x 22 cm)
- US #10 (4.1 x 9.5 in / 11 x 24 cm)
- US #7¾ (3.9 x 7.5 in. / 10 x 19 cm)
- US #9 (3.9 x 8.9 in. / 10 x 23 cm)

**Photos**
- 4 x 6 in. / 10 x 15 cm
- 4 x 7 in. / 10 x 18 cm
- 4 x 8 in. / 10 x 20 cm
- 4 x 12 in. / 10 x 31 cm
- 5 x 7 in. / 13 x 18 cm
- 7 x 10 in. / 18 x 25 cm
- 8 x 10 in. / 20 x 25 cm
- US Letter (8.5 x 11 in. / 22 x 28 cm)
- A4 (8.3 x 11.7 in. / 21 x 30 cm)
Product and Safety Specifications

**Ink cartridges**

- **Ink handling**: 2-cartridge, 5-ink system
- **Ink life**: 1-year warranty from date of purchase

**Connectivity**

- **Protocols supported**: USB 2.0 High Speed; DPOF
- **Devices supported**: Computers with WINDOWS OS and computers with MAC OS; memory cards (SD, XD, MS/Duo, MMC, SDHC); PICTBRIDGE Technology enabled cameras, flash drives; iPhone (iOS 3.0 or later), iPod touch (2nd generation or later), iPad; most Wi-Fi enabled BLACKBERRY devices with OS 4.5 or later; ANDROID OS devices (OS 2.0 or later)
- **Image formats supported**: Image printing supports JPEG (EXIF v2.21 non-progressive); does not support progressive JPEG format; image scanning supports scanning to JPG and non-searchable PDF
- **Number of USB ports**: Two USB 2.0 high-speed ports: one device port on the back for connecting the printer to the computer (as needed), one host port in the front for connecting USB devices front
- **Wi-Fi technology supported**: 802.11b/g/n, WPA/WPA2, WPS, and WEP

**Software support**

- **Application support**: Third-party image-management software; optical character reader (OCR) support for documents
- **Media support**: Plain paper, photo paper, envelopes, greeting cards, card stock, and labels
- **Scanner support**: TWAIN and WIA, WIA2 (VISTA OS and WINDOWS 7), ICA (MAC OS) and TWAIN (on MAC OS 10.5), including segmentation scanning
- **Update support**: Software and firmware updates available through Web support
Physical specifications

**Power**  Input: 110-240 V AC, 50–60 Hz
The printer shall only be used with the provided switching adapter.
Manufacturer and model:
Chicony Power Technology Co., Ltd.
model CPA09-020A
Flextronics Sales & Marketing (A-P) Ltd.
model KOD-A-0040ADU00-101

**Storage dimensions**  462 mm (18.9 in.) long x 432 mm (17.0 in.) wide x 260 mm (10.2 in.) high with input and output trays closed

**Operating dimensions**  477 mm (19.5 in.) long x 557 mm (21.9 in.) wide x 260 mm (10.2 in.) high with input and output trays fully extended for operation

**Weight**  6.9 kg (15.2 lb) without power supply, printhead, or ink cartridges

**Operating range**  5° to 35°C (41° to 95°F), 15 to 85% RH

**Full image quality environmental range**  15° to 30°C (59° to 86°F), and 20 to 80% RH

**Energy efficiency**  ENERGY STAR® Qualified

Warranty

**Product**  One year from purchase (with proof of purchase)
**Printhead**  One year from purchase (with proof of purchase)
System requirements

Computer with WINDOWS OS

<table>
<thead>
<tr>
<th>Computer</th>
<th>Minimum</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating System</td>
<td>WINDOWS 7, VISTA, or XP (SP2 or later)</td>
</tr>
<tr>
<td>CPU</td>
<td>INTEL CELERON Processor</td>
</tr>
<tr>
<td>Clock speed</td>
<td>1.2 GHz</td>
</tr>
<tr>
<td>Memory</td>
<td>512 MB RAM</td>
</tr>
<tr>
<td>Available hard disk space</td>
<td>500 MB available</td>
</tr>
<tr>
<td>Interface</td>
<td>USB 2.0 High Speed</td>
</tr>
<tr>
<td>Removable drive</td>
<td>CD-ROM</td>
</tr>
</tbody>
</table>

Computer with MAC OS

<table>
<thead>
<tr>
<th>Computer</th>
<th>Minimum</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating System</td>
<td>MACINTOSH OS X 10.5 or later</td>
</tr>
<tr>
<td>CPU</td>
<td>PowerPC G4, G5, or INTEL-based MAC</td>
</tr>
<tr>
<td>Clock speed</td>
<td>1.2 GHz</td>
</tr>
<tr>
<td>Memory</td>
<td>512 MB RAM</td>
</tr>
<tr>
<td>Available hard disk space</td>
<td>200 MB available</td>
</tr>
<tr>
<td>Interface</td>
<td>USB 2.0 High Speed</td>
</tr>
<tr>
<td>Removable drive</td>
<td>CD-ROM</td>
</tr>
</tbody>
</table>
Safety information

KODAK OFFICE HERO 6.1 All-in-One Printer is a Class 1 LED Product.

- Always follow all warnings and instructions marked on the product.
- Use only a Hipro HP-A0601R3 or Flextronics VP-09500084-000 certified external power supply (provided with the product).
- Use only the power cord that comes with the product (or an approved power cord greater than or equal to H05W-F, 2G, 0.75 mm²). Using another power cord may cause fire and/or shock. Do not use the included power cord with any other equipment.
- If you do not use this product for a long period of time, unplug it from the electrical outlet.
- Always turn this product off by using the On/Off button. Wait until the On/Off button stops flashing before removing the power plug from the outlet.
- Do not allow the power cord to become damaged or frayed.
- If you need to use an extension cord with this product, make sure that the ampere rating of the product does not exceed the ampere rating of the extension cord.
- Place the product on a flat, stable surface that extends beyond the product’s base in all directions. This product will not operate properly if tilted or at an angle.
- When storing or transporting this product, do not tilt or stand it on its side. Never turn this product upside down (ink can leak out of the product).
- Avoid placing this product in an environment that is subject to rapid changes in temperature or humidity, mechanical shocks, vibration, or dust. Do not place near radiators, heating vents, or in direct sunlight.
- Leave enough room around this product for sufficient ventilation.
- Do not block this product’s covers or openings, or insert any objects through slots.
- Do not use aerosol products inside or around this product.
- Do not spill any liquid on this product.
- Do not attempt to repair or service this product.
- If the power cord or plug is damaged, if any liquid has been spilled onto the product, if the product has been dropped or the case damaged, if the product does not operate normally or exhibits a major change in performance level, unplug this product and contact Kodak at www.kodak.com/go/contact.

For Service Personnel:

⚠️ CAUTION:
Risk of explosion if battery is replaced by an incorrect type. Dispose of used batteries according to local instructions.
LCD screen safety

- Use only a dry, soft cloth to clean the LCD screen. Do not use any liquid or chemical cleaners.
- If the LCD screen is damaged, contact Kodak immediately. If any of the solution from the display gets on your hands, wash them thoroughly with soap and water.

Ink cartridge safety

- Keep all ink cartridges out of the reach of children.
- If ink gets on your skin, wash with soap and water. If ink gets into your eyes, flush immediately with water. If any discomfort or change in vision persists after washing, seek medical attention immediately.
- For MSDS information on inks, go to www.kodak.com/go/MSDS.

NOTE: You will need the catalog number from the ink package.
Regulatory compliance

FCC statement

The United States Federal Communications Commission (in CFR 47 Part 15.105) has specified that the following notice be brought to the attention of the users of this product:

NOTE: This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

• Reorient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver
• Connect the product into an outlet on a circuit different from that to which the receiver is connected.
• Consult the dealer or an experienced radio/TV technician for help.

CAUTION:
Pursuant to Part 15.21 of the FCC Rules, any changes or modifications to this product not expressly approved by Eastman Kodak Company might cause harmful interference and void the FCC authorization to operate this product.

The radiated energy from this product is well below the FCC radio frequency exposure limits. Nevertheless, the product shall be used in such a manner that the potential for human contact during normal operation is minimized. This product and any attached external antenna, if supported, shall be placed in such a manner to minimize the potential for human contact during normal operation. In order to avoid the possibility of exceeding the FCC exposure limits, human proximity shall not be less than 20 cm (8 inches) during normal operation.
Canadian statements

This product meets the applicable Industry Canada technical specifications. Operation is subject to the following two conditions: (1) this device may not cause interference, and (2) this device must accept any interference, including interference that may cause undesired operation of the device.

This Class B digital apparatus complies with Canadian ICES-003.

Industry Canada (IC) Radiation Exposure Statement

This equipment complies with IC radiation exposure limits set forth for an uncontrolled environment. This equipment should be installed and operated with a minimum distance of 20 cm between the radiator and your person.

European compliance statement

Hereby, Eastman Kodak Company declares that this KODAK all-in-one wireless printer is in compliance with the essential requirements and other relevant provisions of Directive 1999/5/EC.

German compliance statement

⚠️ CAUTION:
This device is not intended for use in the direct field of view at visual display workplaces. To avoid incommoding reflections at visual display workplaces this device must not be placed in the direct field of view.

⚠️ VORSICHT:
Das Gerät ist nicht für die Benutzung im unmittelbaren Gesichtsfeld am Bildschirmarbeitsplatz vorgesehen. Um störende Reflexionen am Bildschirmarbeitsplatz zu vermeiden, darf dieses Produkt nicht im unmittelbaren Gesichtsfeld platziert werden.

Noise emissions for this equipment do not exceed 70 dB(A).

This equipment is not intended for use in the work place in accordance with BildscharbV regulations.

Das Gerät ist nicht für die Benutzung am Bildschirmarbeitsplatz gemäß BildscharbV vorgesehen.
REACH Article 33 declarations

Go to www.kodak.com/go/REACH for information about the presence of substances included on the candidate list according to article 59(1) of Regulation (EC) No. 1907/2006 (REACH).

Waste electrical and electronic equipment labeling

In the European Union, do not discard this product as unsorted municipal waste. Contact your local authorities or go to www.kodak.com/go/recycle for recycling program information.

ENERGY STAR® Qualified

To conserve energy, this printer will enter a reduced power (sleep) mode automatically after 1 hour. You can adjust the delay time (in 0.5 hour increments) up to 4 hours. Increasing the delay time may result in reduced energy savings.

ENERGY STAR and the ENERGY STAR mark are registered U.S. service marks. As an ENERGY STAR partner, Kodak has determined that this product meets ENERGY STAR Guidelines for energy efficiency. For more information on the ENERGY STAR program, see www.energystar.gov.
Warranty Information

Limited Warranty
Kodak warrants Kodak consumer electronic products and accessories ("Products"), excluding batteries, to be free from malfunctions and defects in both materials and workmanship for one year from the date of purchase. Retain the original dated sales receipt. Proof of the date of purchase will be required with any request for warranty repair.

Limited Warranty Coverage
Warranty service is only available from within the country where the Products were originally purchased. You may be required to send Products, at your expense, to the authorized service facility for the country where the Products were purchased. Kodak will repair or replace Products if they fail to function properly during the warranty period, subject to any conditions and/or limitations stated herein. Warranty service will include all labor as well as any necessary adjustments and/or replacement parts. If Kodak is unable to repair or replace a Product, Kodak will, at its option, refund the purchase price paid for the Product provided the Product has been returned to Kodak together with proof of the purchase price paid. Repair, replacement, or refund of the purchase price are the sole remedies under this warranty. If replacement parts are used in making repairs, those parts may be remanufactured or may contain remanufactured materials. If it is necessary to replace the entire Product, it may be replaced with a remanufactured Product. Remanufactured Products, parts and materials are warranted for the remaining warranty term of the original Product, or 90 days after the date of repair or replacement, whichever is longer.

Limitations
This warranty does not cover circumstances beyond Kodak's control. This warranty does not apply when failure is due to shipping damage, accident, alteration, modification, unauthorized service, misuse, abuse, use with incompatible accessories or attachments (such as third party ink or ink tanks), failure to follow Kodak's operation, maintenance or repacking instructions, failure to use items supplied by Kodak (such as adapters and cables), or claims made after the duration of this warranty. KODAK MAKES NO OTHER EXPRESS OR IMPLIED WARRANTY FOR THIS PRODUCT, AND DISCLAIMS THE IMPLIED WARRANTIES AND CONDITIONS OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. In the event that the exclusion of any implied warranty is ineffective under the law, the duration of the implied warranty will be one year from the purchase date or such longer period as required by law. The option of repair, replacement, or refund is Kodak's only obligation. Kodak will not be responsible for any special, consequential or incidental damages resulting from the sale, purchase, or use of this product regardless of the cause. Liability for any special consequential or incidental damages (including but not limited to loss of revenue or profit, downtime costs, loss of the use of the equipment, cost of substitute equipment, facilities or services or claims of your customers for such damages resulting from the purchase, use or failure of the Product), regardless of cause, or for breach of any written or implied warranty is expressly disclaimed.
Your Rights
Some states or jurisdictions do not allow exclusion or limitation of incidental or consequential damages, so the above limitation or exclusion may not apply to you. Some states or jurisdictions do not allow limitations on how long an implied warranty lasts, so the above limitation may not apply to you. This warranty gives you specific rights, and you may have other rights which vary from state to state or by jurisdiction. Your statutory rights are not affected.

Outside the United States and Canada
In countries other than the United States and Canada, the terms and conditions of this warranty may be different. Unless a specific Kodak warranty is communicated to the purchaser in writing by a Kodak company, no warranty or liability exists beyond any minimum requirements imposed by law, even though defect, damage, or loss may be by negligence or other act.

Declaration of Conformity
See www.kodak.com/go/declarationofconformity.
Index

A
access door, 1
ADF (Automatic Document Feeder)
capacity, 122
loading, 46
location, 1
paper-edge guides, 1
ANDROID OS Device, printing from, 61
Apple Macintosh
see MAC OS computer
attention light location, 2
auto answer button location, 3
auto answer, setting for faxing, 91

B
back button location, 3
black-and-white
copies, 64, 69
fax, sending, 97
scanning, 76, 77
BLACKBERRY Device, printing from, 60

cancel button location, 2
cleaning
document backing, 103
printer, 102
scanner glass, 103
cleanout area, rear-access, 1
Cloud printing
setting up, 33
color
copies, 64, 69
fax, sending, 97
scanning, 76, 77
components, 1
country/region, setting, 6
cover page, fax, 95
date and time, setting, 6
declaration of conformity, 133
defaults
resetting, 6, 114
save copy settings as
documents, 64
photos, 69
save scan settings as, 76, 77
darkening copies
documents, 64
photos, 69
default settings, printing photos, 54
document backing, 103
printer, 102
Scanner glass, 103
Country/region, setting, 6
Cover page, fax, 95
Date and time, setting, 6
Declaration of conformity, 133
Defaults
Resetting, 6, 114
Save copy settings as
Documents, 64
Photos, 69
Save scan settings as, 76, 77
Darkening copies
Documents, 64
Photos, 69
Default settings, printing photos, 54
distinctive ring, 90
document backing, cleaning, 103
documents
  paper sizes, 123
  printing, 47—49
  printing two-sided, 47—49
downloading (updating)
  printer firmware, 112—113
  software, 112—113
DPOF (digital print order format), 55
DPOF (digital print order format) printing
  See tagged images, printing
duplexer, 1
duplexing, 47—49, 65—66

E
ENERGY STAR qualification, 131
energy-saving sleep mode, 6
enlarging copies
  documents, 63, 64
  photos, 68, 70
envelopes
  capacity, 43
  loading, 43
  sizes, 39, 123
Ethernet network
  changing from USB, 16
  connecting printer to, 14
  MAC OS computer, connecting, 16
  requirements for connecting, 14
  WINDOWS OS computer, connecting, 16
Ethernet port, 1
ext out phone port, 1
extender
  output tray, 1

F
fax
  memory, 122
  phonebook, 122
  quick dial, 122
  resolution, 122
fax mode button location, 2
fax system specifications, 122
faxing, 83—100
  activity log, 90
  answering machine setup, 86
  answering service setup, 87
  brightness and resolution, 96
  call waiting
    disable code, 89
    disabling, 89
  confirmation page, 90
  cover page, 90, 95
  darkening, 96
  dedicated phone line setup, 86
dialing mode
  pulse, 91
tone, 91
distinctive ring, 90
duplexing mode, 47—49, 65—66
DPOF (digital print order format), 55
downloading (updating)
  printer firmware, 112—113
  software, 112—113
DPOF (digital print order format) printing
  See tagged images, printing
duplexer, 1
duplexing, 47—49, 65—66

E
ENERGY STAR qualification, 131
energy-saving sleep mode, 6
enlarging copies
  documents, 63, 64
  photos, 68, 70
envelopes
  capacity, 43
  loading, 43
  sizes, 39, 123
Ethernet network
  changing from USB, 16
  connecting printer to, 14
  MAC OS computer, connecting, 16
  requirements for connecting, 14
  WINDOWS OS computer, connecting, 16
Ethernet port, 1
ext out phone port, 1
extender
  output tray, 1

F
fax
  memory, 122
  phonebook, 122
  quick dial, 122
  resolution, 122
fax mode button location, 2
fax system specifications, 122
faxing, 83—100
  activity log, 90
  answering machine setup, 86
  answering service setup, 87
  brightness and resolution, 96
  call waiting
    disable code, 89
    disabling, 89
  confirmation page, 90
  cover page, 90, 95
  darkening, 96
  dedicated phone line setup, 86
dialing mode
  pulse, 91
tone, 91
distinctive ring, 90
duplexing mode, 47—49, 65—66
DPOF (digital print order format), 55
downloading (updating)
  printer firmware, 112—113
  software, 112—113
DPOF (digital print order format) printing
  See tagged images, printing
duplexer, 1
duplexing, 47—49, 65—66

E
ENERGY STAR qualification, 131
energy-saving sleep mode, 6
enlarging copies
  documents, 63, 64
  photos, 68, 70
envelopes
  capacity, 43
  loading, 43
  sizes, 39, 123
Ethernet network
  changing from USB, 16
  connecting printer to, 14
  MAC OS computer, connecting, 16
  requirements for connecting, 14
  WINDOWS OS computer, connecting, 16
Ethernet port, 1
ext out phone port, 1
extender
  output tray, 1

F
fax
  memory, 122
  phonebook, 122
  quick dial, 122
  resolution, 122
fax mode button location, 2
fax system specifications, 122
faxing, 83—100
  activity log, 90
  answering machine setup, 86
  answering service setup, 87
  brightness and resolution, 96
  call waiting
    disable code, 89
    disabling, 89
  confirmation page, 90
  cover page, 90, 95
  darkening, 96
  dedicated phone line setup, 86
dialing mode
  pulse, 91
tone, 91
distinctive ring, 90
duplexing mode, 47—49, 65—66
DPOF (digital print order format), 55
downloading (updating)
  printer firmware, 112—113
  software, 112—113
DPOF (digital print order format) printing
  See tagged images, printing
duplexer, 1
duplexing, 47—49, 65—66

E
ENERGY STAR qualification, 131
energy-saving sleep mode, 6
enlarging copies
  documents, 63, 64
  photos, 68, 70
envelopes
  capacity, 43
  loading, 43
  sizes, 39, 123
Ethernet network
  changing from USB, 16
  connecting printer to, 14
  MAC OS computer, connecting, 16
  requirements for connecting, 14
  WINDOWS OS computer, connecting, 16
Ethernet port, 1
ext out phone port, 1
extender
  output tray, 1

F
fax
  memory, 122
  phonebook, 122
  quick dial, 122
  resolution, 122
fax mode button location, 2
fax system specifications, 122
faxing, 83—100
  activity log, 90
  answering machine setup, 86
  answering service setup, 87
  brightness and resolution, 96
  call waiting
    disable code, 89
    disabling, 89
  confirmation page, 90
  cover page, 90, 95
  darkening, 96
  dedicated phone line setup, 86
dialing mode
  pulse, 91
tone, 91
distinctive ring, 90
duplexing mode, 47—49, 65—66
DPOF (digital print order format), 55
downloading (updating)
  printer firmware, 112—113
  software, 112—113
DPOF (digital print order format) printing
  See tagged images, printing
duplexer, 1
duplexing, 47—49, 65—66
I
Image Capture software, 57
image formats supported, 124
index card stock, sizes, 123
ink cartridge, 1
  replacing, 105—107
ink levels, 114
IP address
  setting up, 11
  viewing, 12
iPad, printing from, 60
iPhone, printing from, 60
iPhoto software, 57
iPod touch device, printing from, 60
iron-on transfers, sizes, 38, 123

K
keyboard on LCD, using, 8, 93
Kodak all-in-one printer software, 4
KODAK Email Print Service
  printing from, 59
  setting up, 34
KODAK Home Center Software
  see Home Center Software

L
label sizes, 123
labels, 38
language, setting, 6
LCD location, 2
lightening copies
  documents, 64, 65
  photos, 69, 71
line in, 1
line in phone port, 1
loading originals
  for copying, 62
  for faxing, 95
  for scanning, 75
  on scanner glass, 45
  using ADF, 46
loading paper tray
  envelopes, 43
  photo paper, 42
  plain paper, 40
memory card slot, 1
memory cards, 51

N
narrow-ruled paper, printing, 49
navigation button location, 2
network, Ethernet
  connecting printer to, 14
  requirements for connecting, 14
network, wireless
  see wireless network
numeric keypad location, 2
numeric keypad on control panel, using, 94

O
OK button location, 2
Online Printer Management Tool, 17—37
  editing Fax Phone Book, 94
  using to configure printer settings, 19, 20
originals, loading
  for copying, 62
  for faxing, 95
  for scanning, 75
  on scanner glass, 45
  using ADF, 46
output tray, 1
  extender, 1
paper, 38—46
  loading tray
    envelopes, 43
    photo paper, 42
    plain paper, 40
  sizes, 123
  sizes supported, 39
  types supported, 38
paper stop, 1
paper tray, 1
  capacity, 122
  envelopes, 43
  photo paper, 42
  plain paper, 40
phonebook
  adding new entries, 93
  deleting entries, 94
  editing entries, 93
phonebook button location, 2
photo
  finding, 50
  viewing, 50
photo mode button location, 3
photo paper  
capacity, 42
loading, 42
photo paper sizes, 123
photo printing  
image enhancement, 120
print sizes, 120
quality, 120
scene balance, 120
pictures  
printing, 50—56
DPOF, 55
tagged, 55
transferring to computer, 57
pictures  
printing, 50—56
DPOF, 55
tagged, 55
transferring to computer, 57
PIN, setting, 26, 31
plain paper  
capacity, 40
loading, 40
port  
Ethernet, 1
front USB, 1
phone, 1
phone port  
ext out, 1
power cord, 1
USB, 1
power button location, 2
power cord port, 1
power status light, 119
printer  
cleaning instructions, 102
defaults, resetting, 6, 114
hostname, 12
maintaining, 102—114
settings, configuring, 6
supplies  
ordering, 5
recycling, 102
printer connection, changing  
USB to Ethernet, 16
printer connection, changing USB to wireless, 15
printhead, 1
removing, 109
replacing, 108—111
printing, 47—56, 58—59
documents, 47—49
two-sided, 47—49
forms, 49
from ANDROID OS Device, 61
from BLACKBERRY Device, 60
from iPad, 60
from iPhone, 60
from iPod touch device, 60
from mobile devices, 58—59
document, 49
grocery list, 49
narrow-ruled paper, 49
photos, 53—54
pictures, 50—56
DPOF, 55
from memory card, 51
tagged, 55
tagged images, 6
tag list, 49
sheet music, 49
speed, 120
tic-tac-toe, 49
two-sided documents, 47—49
using Google Cloud Print, 58
using KODAK Email Print Service, 59
wide-ruled paper, 49
quick dial, 93
rear-access cleanout area, 1
receiving fax, 99—100
automatically, 99
manually, 100
recycling printer or supplies, 102
redial button location, 3
reducing copies
documents, 63, 64
photos, 68, 70
regulatory compliance, 129
Canadian, 130
European, 130
German, 130
REACH Article 33 declarations, 131
waste labeling, European Union, 131
reminder list, printing, 49
replacement
ink cartridge, 105—107
printhead, 108—111
resolution, scanning, 73
rings to answer, 88
scan mode button location, 3
scanner glass, 1, 45
cleaning, 103
scanner lid, 1
scanner type, 121
scanning, 72—82
automatically detect pictures, 74
www.kodak.com/go/aiosupport
Index

features, 121
file format
document, 73
picture, 73
from computer, 80—81
from control panel, 75
from Online Printer Management Tool, 82
loading originals, 75
multiple pictures simultaneously, 80
resolution, 73
selecting quality, 74
setting options, 76, 77
Service Set Identifier, 7
setting options, 53—54
settings
copy documents, 63—64
copy photos, 68—69
fax, 88—91
printing photos, 53—54
scanning, 76, 77
sheet music, printing, 49
sleep mode, 6
software
downloading (updating), 112—113
support, 124
specifications, 120—123
ADF, 122
fax system, 122
physical dimensions, 125
power, 125
weight, 125
SSID, 7
start black button location, 2
start color button location, 3
status light
power, 119
Wi-Fi, 119
supplies, ordering, 5
system requirements, 126

T
telephone service
cable, 83
digital subscriber line (DSL), 83, 84
Internet (VOIP), 83
standard, 83
tic-tac-toe, printing, 49
time and date, setting, 6
time to low power, setting, 6
transparencies, 38
transferring pictures to computer, 57
tray, paper, capacity
envelopes, 43
photo paper, 42
plain paper, 40
troubleshooting, 115—119
two-sided copying, 65—66
two-sided printing, 47—49

U
upgrading
firmware, 112—113
software, 112—113
USB connection, changing
to Ethernet, 16
USB connection, changing to wireless, 15
USB port, 1

V
viewing photos, 50

W
warranty, 125
ink, 124
Web support
Electronics Industry Alliance, 102
ENERGY STAR program, 131
networking, 115
REACH Article 33 declarations, 131
recycling, 102
wide-ruled paper, printing, 49
Wi-Fi
Setup wizard, 7
status light, 3, 119
technology supported, 124
WINDOWS OS computer
connecting printer
Ethernet, 16
wireless network
configuration, viewing and printing, 12
connecting to, 7—13
additional KODAK All-in-One Printer(s), 13
from USB, 15
non-WPS router, 7
printer on additional computers, 13
using Wi-Fi Setup wizard, 7
WPS router, 9
IP address, setting up, 11
settings, configuring, 7
subnet, viewing, 12
WPS, 7
WPS router, 9